MX-AOPC UA Logger User’'s Manual

Version 2.1, June 2022

www.moxa.com/product

MOXAN

© 2022 Moxa Inc. All rights reserved.



MX-AOPC UA Logger User’s Manual

The software described in this manual is furnished under a license agreement and may be used only in accordance
with the terms of that agreement.

Copyright Notice

© 2022 Moxa Inc. All rights reserved.

Trademarks

The MOXA logo is a registered trademark of Moxa Inc.
All other trademarks or registered marks in this manual belong to their respective manufacturers.

Disclaimer

Information in this document is subject to change without notice and does not represent a commitment on the part of

Moxa.

Moxa provides this document as is, without warranty of any kind, either expressed or implied, including, but not
limited to, its particular purpose. Moxa reserves the right to make improvements and/or changes to this manual, or to
the products and/or the programs described in this manual, at any time.

Information provided in this manual is intended to be accurate and reliable. However, Moxa assumes no responsibility
for its use, or for any infringements on the rights of third parties that may result from its use.

This product might include unintentional technical or typographical errors. Changes are periodically made to the
information herein to correct such errors, and these changes are incorporated into new editions of the publication.

Technical Support Contact Information

www.moxa.com/support

Moxa Americas
Toll-free: 1-888-669-2872

Tel: +1-714-528-6777
Fax: +1-714-528-6778
Moxa Europe

Tel: +49-89-3 70 03 99-0
Fax: +49-89-3 70 03 99-99

Moxa India
Tel: +91-80-4172-9088
Fax: +91-80-4132-1045

Moxa China (Shanghai office)
Toll-free: 800-820-5036

Tel: +86-21-5258-9955
Fax: +86-21-5258-5505
Moxa Asia-Pacific

Tel: +886-2-8919-1230
Fax: +886-2-8919-1231



Table of Contents

031 o Yo [T T o] o o 1-1
[0 A= A= 1-2
1)Y= 0 T =T [ =T o 4T = 1-2
1Y 0Tl 1= o = PP 1-3

Getting Started......ciicviiiiiiii i i AR AR ara . 2-1
Designing the System ArChit@CtUIe. . ... o e a e aaaeanens 2-2
INStalling the MX-AOPC UA LOGG I .. uuiitiitieieeaeae et r st st s e sa e et e n e a e e n e e e e se e e re e e s e e e rneanernernennss 2-4
Opening the Configuration CONSO0IE ...ttt et e e s e e e st ae e e raeaaenss 2-4
Configuring the MX-AOPC UA LOGGer SettiNgS 1 .vuuititii ittt ettt e st e e se st aae e ae s e e e s e e reenereaneaneanennss 2-5
ConNEeCting 0 the MX-AOPC UA S Vel ottt ettt et s e s ta s et ae e eaa e e aae e re e e e rneanerneanennss 2-9

Getting the Server Endpoint from the MX-AOPC UA SEIVEI ... ..iiiiiiiiiiiiiiitiiiitiei e raeaneaes 2-9

CoNNECEING t0 MX-AOPC UA SO VOIS .ttt ettt te et te et e st e st e st e st et aesate st e taneaaneaanesaneaanens 2-9
(O /= L] T T o T T 1= = 2-13
Starting RUNEIME SEIVICE. .ttt ettt ettt ane et 2-16
1] = [t ] o =T ol o T [ T 2-18
Testing the Data Supplement FUNCHION. ... e e e e e e e e e e e e neenens 2-19
Testing the Data Supplement on Demand FUNCEION .....viieiiriiiiii et 2-24
Testing the Data Supplement on Schedule FUNCHION ..o e e ee e 2-27

Configuration CONSOIE ....ciuiiiiiirii i i i s i s s s r s s s r s s a s aan s aaan s a s n s a s nn s n s 3-1
3= T ST == T @ AV =T o T 3-2
LN =T TG =T 0 3-3

PPN 3-3
= Y] 3-4
o T T =T o 3-5
Lo e 3 PP 3-6
RUN I et 3-11
1= o P 3-11

LT V=] gl o 0 T T T 3 L= o 4-1

L= VL= 1= 0001 =T o 4-2
Getting the Server Endpoint from an MX-AOPC UA SEIVeI .....uuiuiieinieteineateinaneeaneneeaerneenernranernranennss 4-2
DiSCOVENNG MX-AOPC UA SEIVEIS ...ttt a e s s s e s s e s e s e e e s e aneas 4-3

1= V= o o1 o= T o o R 4-5
Connecting to the discovered MX-AOPC UA SeIVEr .....ieiii et re e reate e s e e rneanennss 4-5
Editing the connection settings of the discovered MX-AOPC UA SEIVEeI.....iiuiiiiiiiiiiiiiii e ieeenaeaneans 4-6
Deleting the connection settings of the discovered MX-AOPC UA SEIVer.......cvviiiiiiiiiiiiiiiiiniinaiiaenans 4-7

I T T 1= gl - g T Y e 1= 1 1= o L 5-1
[0 T [T i ] o U o 5-2

Adding a Logger Group t0 @ LOgger GroUP LISt ...uuuueiieie i ieeessstenseneeaseeeaese e seenereenernennens 5-2
[=lo [1ullo Jr= N WoTa o [T ol €] o 1U ] o H PPN 5-3
(D=1 L1 ] g o = T oY o 1= o 11 o 5-3

0T T T 5-4
P-Ye la T gTe I= T o Yo Lo [T g (o - T =T B €] o YU o T PP 5-4
L= 1T J= 0 I T T 1= o 5-7
(D22 (] g o = T oY o = o PP 5-8

[ o 1= ol > T=Yolo ] e I Ve [P 5-9
1= (=Tt ol =T F30 (o ol =T oo g 11 0T [ 5-9
1] = [ Ao T ] o o N =Tl ] e | T 1A PP 5-11
[0 Yo o 1= ) =) o B [ 5-14

License Registration and Activation.......ccveiieriersriersrssmsmmasmasmesmammasmarsassarsassassasssssssassassassassnssnssnnnnrs 6-1

System Performance ReferenCe ......cciverieririerisiersmsssmsssassss s s s s sna s sssssnsasssnsassnssnsnnssnsnnsnnsnnsnns A-1

Database Connection SettingS.....uciiiiiiiaiianiarari s e B-1



1

Introduction

The following topics are covered in this chapter:

0 Overview

0 System Requirements

O Specifications



MX-AOPC UA Logger Introduction

Overview

With most remote data acquisition systems, during daily operations additional human resources are needed
to collect data manually from remote storage devices for loading into a database. Even with remote I/O
devices remotely collecting data over a network, software must be developed to handle the task of
converting and uploading data logs. Moxa’s MX-AOPC UA Logger not only makes real-time data collection
much easier, it also simplifies the conversion of historical data into database-ready formats. Moxa’s MX-
AOPC UA Logger interacts directly with our MX-AOPC UA Server, working as a bridge between field data and
cloud storage, as well as stored databases or spreadsheets. The MX-AOPC UA Logger can collate tags from
individual Moxa remote I/O devices into the same cloud, database, or spreadsheet, freeing users from the
need to manipulate data after processing.

One of the benefits of using remote I/O devices is that data can be collected over a network from a central
site. In an ideal operation, after a network failure remote I/O devices should be able to transmit data logs
that were collected while the network was offline. Moxa’s MX-AOPC UA Logger makes this not only possible,
but easy. MX-AOPC UA Loggers provide a standard OPC interface that interacts with MX-AOPC UA Servers
for real-time data collection. After each network connection, an MX-AOPC UA Logger will compare historical
data stored on the microSD cards located in individual ioLogik 2500 devices with the real time data it has
already stored locally, and then supplement any missing data by requesting that the ioLogik 2500
retransmit the lost data. Furthermore, MX-AOPC UA Logger also supports functions for providing data on
schedule and on demand. It will automatically retrieve the lost data when the on-schedule or on-demand
function is triggered.

The MX-AOPC UA Logger includes:

e Logger Runtime Service: Starts as a service by default after installation.

¢ Configuration Console: A configuration tool for configuring settings.

System Requirements

Hardware Requirements

CPU: Intel Pentium 4 or above

RAM: 512 MB (1024 MB recommended)

Communication Interface: Ethernet

Software Requirements

Operating System: Microsoft Windows 7/8/10, Microsoft Windows Server 2003/2008/2012
Microsoft .NET Framework: v3.5 Service Pack 1

Editor (optional): Microsoft Office 2003 (Access or Excel) or later

Database (optional): Oracle database (x86), Microsoft SQL Server (x86), MySQL (x86)
Cloud (optional): Microsoft Azure
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Specifications

OPC Specifications
OPC Unified Architecture: 1.02

Products that Support Data Supplement Auto Mode, on Schedule, and on Demand
Model Names: ioLogik 2500 series
Note: Please check Moxa’s website for the most up-to-date list of supported products.

Fully Supported OPC UA Client Profiles
e Core Client Facet

e User Token: User Name Password Client Facet
e User Token: X509 Certificate Client Facet

e Security Policy: Basic128Rsal5

e Security Policy: None

e Data Access Client Facet

e UA-TCP UA-SC UA Binary

e Attribute Write Client Facet

o Data Change Subscriber Client Facet
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Getting Started

The following topics are covered in this chapter:

m)

QoQaaQ

aaaogaaao

Designing the System Architecture

Installing the MX-AOPC UA Logger

Opening the Configuration Console

Configuring the MX-AOPC UA Logger Settings
Connecting to the MX-AOPC UA Server

> Getting the Server Endpoint from the MX-AOPC UA Server
» Connecting to MX-AOPC UA Servers

Creating Loggers

Starting Runtime Service

Starting Recording

Testing the Data Supplement Function

Testing the Data Supplement on Demand Function

Testing the Data Supplement on Schedule Function
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Designing the System Architecture

The MX-AOPC UA Logger provides two main functions.

e Storing real-time data collected through an MX-AOPC UA Server from individual I/O devices to a
database or spreadsheet.

e Retrieving buffered data stored on a microSD card located in a Moxa device that supports data buffering,
such as the Moxa ioLogik 2500 series, and then supplementing the database or spreadsheet with missing
data.

We recommend using one of the following two scenarios when designing the system architecture:

Scenario 1: Write real-time data to a database, spreadsheet, or Azure Cloud

e MX-AOPC UA Logger saves data from selected OPC tags to a database, spreadsheet, or Azure Cloud. The
data comes from MX-AOPC UA Server only, which collects data from field devices.

e MX-AOPC UA Server, MX-AOPC UA Logger, and Database can be installed either on the same computer
or on different computers. We strongly recommend installing MX-AOPC UA Logger and Database on the
same computer.

SCADA
" p—
.4',;:-' =
=1
Eriim ) == Microsoft Azure
OPC DA
IoT Hub _,
MX-AOPC UA Server MX-AOPC UA Logger Database
g — — H - g
Static IP OPC UA oDBC
y e . |
) A
Moxa AOPC S
Modbus ORACLE b Y
DATABASE MySOL:
Static IP
I
Remote I/0

Scenario 2: Collect real-time data while the network is up and running, and
retrieve buffered data stored in Moxa devices when the network is
disconnected

e Refer to Scenario 1 for real-time data collection.

e When network communication is reestablished, the MX-AOPC UA Logger automatically retrieves buffered
data saved on microSD cards installed in Moxa’s devices when the network was disconnected.

e After retrieving data from the data logs, the MX-AOPC UA Logger automatically saves the data to the
database or spreadsheet.

e The MX-AOPC UA Logger supplements data only for OPC tags, which are selected both in the AOPC
function of the Moxa device with the IOxpress utility (AOPC > Tag Selection), and in the Logger
settings of the MX-AOPC UA Logger with its configuration console.

e For this scenario, microSD cards must be installed in your Moxa devices.

e The MX-AOPC UA Logger’s data supplement function must be enabled (the default), which can be done
with the configuration console under Tools > Data Supplement Settings.
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e If the IP address of the Moxa cellular device is private or dynamic, Cellular Data Access software must
be used to enable the MX-AOPC UA Logger to access Moxa cellular devices. We recommend installing the
Cellular Data Access software and MX-AOPC UA Server on the same computer. Use Moxa’s IOxpress
utility to enable the Cellular Data Access function on the Moxa cellular device at Network > Cellular >
Cellular Data Access. Use the MX-AOPC UA Logger’s configuration console at Tools > Data
Supplement Settings.

When the Moxa cellular device uses a static IP

SCADA

OPC UA
OPC DA

MX-AOPC UA Server MX-AOPC UA Logger Database

Static IP QPC UA 7 oDBC
. :}3} :{_:J A ul
Moxa AOPC ,» &, SQLServer
Modbus ey OoRrRACLE m
pataBase MySOL

Static IP

=
J'[IJ
Remote 10

When the Moxa cellular device uses a private or dynamic IP

SCADA

F"'.'. X

oc..g

OoPC UA
OPC DA

MX-AOPC UA Server MX-AOPC UA Logger Database

Static IP OPC UA o oDBC

A . oy

1 y =
Moxa AOPC t;ﬁ;ﬂu}ar & lsever I el
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¥
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The following software can be downloaded from Moxa’s website at www.moxa.com:

L]

MX-AOPC UA Logger v2.0 or later
MX-AOPC UA Server v2.0 or later
Cellular Data Access v1.2 or later
IOxpress utility v2.1 or later
Moxa device firmware that supports the data supplement function:
» ioLogik 2500 series
] ioLogik 2500-Ethernet v2.2 or later
= ioLogik 2500-HSPA v2.2 or later
=  joLogik 2500-WL1 v2.2 or later

Refer to the MX-AOPC UA Server User’s Manual for instructions on how to install and configure Moxa’s MX-
AOPC UA Server software.

Refer to your Moxa device’s user’'s manual for instructions on installing IOxpress and Cellular Data Access on

a

computer, and for updating your Moxa device’s firmware.

Installing the MX-AOPC UA Logger

The MX-AOPC UA Logger can be downloaded from Moxa’s website at www.moxa.com.

After downloading the file, unzip it and run setup.exe. The installation program will guide you through the
MX-AOPC UA Logger installation process.

NOTE Microsoft .NET Framework v3.5 Service Pack 1 is required before installing MX-AOPC UA Logger. After
the .NET Framework is installed, restart your computer and run setup.exe again to install MX-AOPC UA
Logger.

Opening the Configuration Console

Open the MX-AOPC UA Logger’s configuration console from the Windows Start menu: Start > All
Programs > MOXA - 10 Server > MX-AOPC UA Suite > MX-AOPC UA Logger.

Select the appropriate main network adapter the first time you open the configuration console.

Select Main Metwork Adapter X ]

Main Metwork Adapter: |InteI{R} Ethernet Connection (3) I2181M - |

Mote: The main network adapter needs to be enabled for starting runtime service,
This setting cannot be modified after this configuration.

oK ] | Cancel

2-4
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The configuration console is an configuration tool for configuring Logger Runtime settings. When the

configuration console is launched, it will automatically get the latest configurations from the Logger
Runtime.

}51 MX-AOPC UA Logge

File Server Logger Tools Runtime Help

TEHEBERNEKG 008888

e ﬁ Server Group

&4 Logger Group List

Date Time: Event

£l 1

Service Status: Stopped Time: 08:21:05 Data Supplement Queue: 0000

Configuring the MX-AOPC UA Logger Settings

The MX-AOPC UA Logger settings described below can be configured under the Tools menu.

H MX-AOPCUALogger I
File Server Logger !Touis| Runtime Help

: Data Supplement Settings | @
g 8-

Certificate Management

------- ﬂ Server Group
System Log <

Change Password

Opticns

[k §i Logger Group List

e Change Password

We strongly recommend changing the password the first time you use the Configuration Console. The
default password is moxa, which is needed for verification when exporting the system log to a text file.
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e Data Supplement Settings
Select the Data supplement after network reconnection checkbox if the Moxa product supporting
the data supplement function is connected to an MX-AOPC UA Server.

Select the Data supplement on schedule checkbox if the Moxa product supporting the data
supplement on schedule function is connected to an MX-AOPC UA Server.

Select the Data Supplement through Cellular Data Access checkbox if the IP address of the Moxa
cellular device is private or dynamic.

General Settings
Retry Timeout 30 sec(s) (5 to 600, default: 30)
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network reconnection
[ | pata supplement on schedule

Everyday at 00:00

o

Data loss in the past | 1 day(s) (1 to 7, default: 1)

[ | Data supplement through Cellular Data Access

IF Address O o 0 emilE o

Port |9400 (0 to 65535, default: 9400)

| Folder for supplementary data
Path C:\Users\Public\DocumentsiMoxa MY ADPCL E]

Log Folder for Data Supplement on Demand

C:\Users\Public\Documents Moxa \MXACPCL

[ oK ] [ Cancel
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Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsa15: Sign, Basic128Rsa15: Sign
and Encrypt, or both, importing an OPC UA client’s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC
UA Logger.

Trust Servers | Instance Cerﬁﬁmtes|

Server Mame LRI

i MX-AQPC LA Server urn:CHARLESCHEM-ME:MxX-AQPC UA Server

4 | 1 | b
: Export... | Remaove Trust ' | View Certificate...

Close
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Select the Instance Certificates tab and click on Export Logger Certificate to export the MX-AOPC
UA Logger's CA file to the OPC UA Server.

Cenihcates Menogerer i
Trust Servers | Instance Certificates |

[ View Logger Certificate... ] Certificate MX-AQOPC LUA Logger is from
1/9,/2018 4:74:45 PM to 12/14/2022
4:24:45 PM

[ Export Logger Certificate... ]

[ Reizsue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.
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Connecting to the MX-AOPC UA Server

Getting the Server Endpoint from the MX-AOPC UA Server

Open the MX-AOPC UA Server configuration console and select Tools > OPC UA Settings > Server
Endpoint Settings to go to the MX-AOPC UA Server configuration console to copy the MX-AOPC UA
Server’s Server Endpoint.

Ensure that the status of the Server Endpoint is Valid.

URL Status
opc. top: /192, 168, 127, 200: 53192 MXAOQPC JUAServer Valid

Metwork Interface: |Intel(R) Ethernet Connection (3) 12184M -
Port Number: 53132 '

opc.top: 192, 168, 127, 200: 53192 MY AQPC UAServer

I [ Add ][ Delete ][ Apply ] [ Close ]

Connecting to MX-AOPC UA Servers

1. Click the Server Group and then click the Discovery icon to start discovering MX-AOPC UA Servers.

H MX-AOPC UALogger e,

Eile 5Server Logger Tools Runtime Help

T EalPlERESERG008E

----- ﬁ Server Group

------ & Logger Group List
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2. Select the Local Server option if MX-AOPC UA Server and MX-AOPC UA Logger are installed on the
same computer. Otherwise, select the Remote Server Endpoint option and paste in the Server
Endpoint from the previous step. Type in the MX-AOPC UA Server’s password and then click Next.

ooy ==

() Local Server

| w

i@ Remote Server Endpoint

opc. top: ff192. 168, 127, 200: 53192 MXACPC JUAServer

Password bbb

| <Back || nNext> | [ cancel

2-10
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Getting Started

3. Modify Server Name, and configure Security Policy and Security Mode, which should be the same as
the MX-AOPC UA Server’s UA Settings. If necessary, change the Publish Interval, Sampling Interval,
Queue Size settings, and select or deselect the Discard Oldest settings checkbox, and then click

Finish.

orcoryseres

Server Name  Serverd]

Server Endpoint:

opc.top: /192, 168, 127, 200: 53192 MXACPC UAServer

(max. length = 30; "." is not allowed)

Security Policy [NDHE

™

Security Mode [NOHE

3

Subscription Settings

Publish Interval

Keep Alive Count

Lifetime Count : 1000

Maonitored Item Settings

Sampling Interval 500

Queue Size 10

Discard Oldest

||

||

[=

r

i

-l {0 to 10000, default: 10)
1]

v

(2] s (-1 to 86400000, default: 500)

|4

ms {0 to 85400000, default: 1000)

| <Back || Finsh | | cancel |

4. Select the server and click the Connect icon to connect to the MX-AOPC UA Server.

g
]iMX-AOPC UA Logger

File Server Logger Tools Runtime Help

B

u

TR BERDNSRG0088 88

=5 u Server Group
PN server1(192. 168, 127.200:53192)

(=~ &4 Logger Group List
&5 LoggerGroupl

Server Endpoint:
Security Policy: ~ None

Security Mode: MNone

Subscription Settings

Publish

Keep Alive Count: 10

Lifetime Count: 1000

2-11

opc.tep:ff192. 168.127. 200:53192/MXAOPC/UAServer

Monitored [tem Settings

Interval: 1000 ms Sampling Interval: 500 ms
Queue Size: 10

Discard Oldest:  Yes
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5. Once the server is connected, you will not be allowed to change the server connection settings. To
change the server connection settings, click the Disconnect icon to disconnect the MX-AOPC UA Server,
and then click the Properties icon to change the server connection settings.

g T S e

File Server Logger Iools Runtime Help

rERRBBERENEKRG 008888 :

- Jg Server Group I

Server1(192.168.127.200:53192) Server Endpoint:  opc.teps//192. 168, 127, 200: 53192/MXAOPC/UAServer

Security Policy: None

Security Mode:  None

=8 Logger Group List

@ LoggerGroupl Subscription Settings Monitored Item Settings
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

[Cae=mn s e L aaa

File Server Logger Tools Runtime Help

DERBEBRNSRIG 008888

= U Server Group

‘ Server1(192.168.127.200:53192) Server Endpoint:  opc.tep: /192, 168, 127, 200:53192/MXAOPC/UAServer

Security Policy: ~ None

Security Mode:  None

=~ &4 Logger Group List

&5 LoggerGroupl Subscription Settings Monitored Item Settings
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

NOTE Ensure that the server connection is in connecting status before starting to record data to a database or
spreadsheet.
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Creating Loggers

1. To create a data Logger, click Logger Group List, click the New Logger Group icon, and then type in

the name of the logger group.

B MX-AOPC UA
L o Logger - - -

Eile: Server Logger Tools Runtime Help

U A BB BES

= B Server Group

-£8 Logger Group List

| I—

,
oy

Logger Group Mame LoggerGroupl

{max. length = 30; "."is not allowed)

o) Coma)

2. Click the logger group, and then click the New Logger icon to create a logger.

2-13



MX-AOPC UA Logger Getting Started

3. Type in the name of the logger, select Excel File, Access File, Database, or Azure IoT, and then
modify the root path. Set the source name of the database, or type in the Connection String. Click Next
to continue.

£ e - s - | ;
H MCAOPC UA LoggerT THER TR BELSE SEem oF e " hen = Wy -y
File Server Logger Tools Runtime Help

rereeenlBRa 008888

= . Server Group Logger Name Type Output
------- I server1(192.168.127.200:5319

s L =

Logger Mame

(max. length = 30; only 20 if using Orade Database)

(@) Excel File:
Root Path: C:\Users\Public\Documents Moxa \MXACPCLogger \Logger

File separated every min. {default: 60)

() Access File:

Root Path: i C:\Users\Public\Documents\Moxa \MXAOPCLogger \Logger |

() Database:

Source Name: | Setting

) Azure IoT:

Date Time Connection 5tring:

2018/01/24 08:49:15

<gack || mext> | [ cancel

4. If necessary, modify the name and order of Table Fields. Add <DATA_TYPE>,
<SERVER_UTC_TIMESTAMP>, efc., if they are required to be recorded into the database or spreadsheet,
and then click Finish.

woerseins: o N ==
Data Field *Table Field Data Type w | |

<UNIT> <UNIT> String
<SOURCE_UTC_TIMESTA... <SOURCE_UTC_TIMESTA... **String
<SOURCE_TIMEZONE > <SOURCE_TIMEZONE > Float
<DATA_TYPE>

<SERVER_UTC_TIMESTA...
<SERVER_TIMEZOME >

OOoOE

<QUALTTY >
=
*max, length =30; . * [ 1" are not allowed.
** option: DateTime or String
Automatically start recording when service starts running.
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5. Click the Refresh button to get the latest MX-AOPC UA Server OPC tags.

& MX-AOPC UA Logger

Server Logger Tools Runtime Help )
= = o = - : 4 - - - - |
OCFRAeEBENERG 00884848 t
=] - Server Group ReCraty E |
‘ Server1(192.168.127.200:53192) —  —
{ St | [ swp |
Automatically start recording when service starts running
Tag Selection
=~ Logger Group List [Senrerl VI [&II Device V]@
B---ﬁa\ggeerupl Available Tags d Tags
¥ Logger1|
Tag Mame E] Tag Name
Server Name  Tag Name Description
Property
Type: Excel
Output:  C:\Wsers\Public\Documents\MoxaMXAOPCLogger\LoggeriLogger 120180124 005331 E]
Table: Loggeri
Data Field Table Field Data Type Order
<TAG_ID> <TAG_ID> String i
<VALUE=> <VALUE> String 2
<UNIT> <UNIT> String 3
<50URCE_UTC_TIMESTAMP > <SOURCE_UTC_TIMESTAMP> DateTime 4
<50URCE_TIMEZONE > <50URCE_TIMEZONE > Float 5

6. Click the appropriate arrow buttons to add items to or remove items from the Selected Tags list.

File Server Logger Tools Runtime Help )

— e e = = B E i - - E |

ITEHRBEBRD -. .. &

=5 ' Server Group FECEa E |

‘ Server1(192.168.127.200:53192) — ——
| st || swp |
Automatically start recording when service starts running
Tag Selection
=8 Logger Group List ISenrerl vl il Device '] @
=88 gk i Available Tags lected Tags
Logger1
9 Tag Name i E] Tag Name

% DeviceGroup L.Device l.TagGroL.u:ll.Tal:| E] Y 2542-01.A1-00
W E2292-0LA1-00 E] W 2592-01.A1-01
WE22492-0LA1-01 Y 2592-01.A1-02
WE2292-0LA1-02 - E W 2592-01.A1-03
q i + Y 2542-01.010-00 -
Server Mame  Tag Name Description 2
Serverl W 2542-01.A1-00 Desc o
Serverl W 2542-01.A101 Desc E
Serverl W 2542-01.A1-02 Desc
Serverl T 2542-01.A1-03 Desc -
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Starting Runtime Service

After connecting the MX-AOPC UA Server and creating the Logger, click the Start Runtime Service icon to
start running the MX-AOPC UA Logger service.

& MX-AOPC UA Logq

File Server Logger Tools Runtime Help

rereERNERaflos8 ss

-
- ‘ Server Group T B
H 5 Server1(192. 168,127,200:53192) I e W e
Start | Stop |
[ Automatically start recording when service starts running
Tag Selection
(l = E;f Logger Group List [Ser\ferl '] |l Device '] @
B LoggerGroupl Available Tags Selected Tags
Logger1
Q Tag Name 5 » Tag Name =
% DeviceGroup1.Device 1.TagGroup 1.TaD E] & 2542-01.A1-00 3
Wy E2242-01.A1-00 E iy 2542-01.A1-01
Wy E2242-01L.A1-01 Wy 2542-01.A1-02
T E2242-01.A1-02 - E] W 2542-01.A1-03
« ] " i 2542-01.010-00 -
Server Name  Tag Name Description E
Serverl Y 2542-01.A1-00 Desc o
Serverl Y 2542-01.A1-01 Desc 3
Serverl Y 2542-01.A1-02 Desc
Serverl Y 2542-01.A1-03 Desc -

A green light next to the logger name indicates that the logger is ready to record.

& MX-AOPC UA Logges

File Server Logger Tools Runtime Help
= E———— ) — = . (|
IFAEEROSRGE 008888 l
= ‘ Server Group P =
- [ Server1{192.168.127.200:53132) —
Start | Stop |
[ Automatically start recording when service starts running
Tag Selection
(- E Logger Group List | -| | | |C |
B o Available Tags Selected Tags
Tag Name | W I Tag Name
LT
—
(EAN
[« ]
J
Server Name  Tag Name Description =
Serverl Y 2542-01.A1-00 Desc [
Serverl Y 2542-01.A1-01 Desc 3
Serverl Y 2542-01.A1-02 Desc
Serverl Y 2542-01.A1-03 Desc -

2-16




MX-AOPC UA Logger Getting Started

A yellow light next to the logger name indicates that the logger setting is not correct. Check the settings of
the logger, and then confirm the database or spreadsheet settings again.

MX-AQPC UA Logger

File Server Logger Tools Runtime Help
A o e — o = - p— = T — ‘
TEFRERONSRGT008888
| Bﬁ Server Group R Tty f=
ﬁ Server1(192. 168,127,200:53192)
Start Stop
I Automatically start recording when service starts running I
Tag Selection
=] H Logger Group List C
= B La00erroun Available Tags Selected Tags
Tag Name » Tag Mame
>
4
«
Server Name  Tag Name Description

You will not be allowed to modify the server connection and logger settings when runtime service is running.
To stop runtime service, click the Stop Runtime Service icon.

& MX-AOPC UA Lag ? S|

File Server Logger Tools Runtime Help

IR BERNEKG

olgls & s &

il = ﬁServerGrcup

Recording —
@ Server1(192. 165.127.200:53192)
Automatically start recording when service starts running
Tag Selection
= §:f Logger Group List ]
=< LOSQEVGVDUDl Available Tags Selected Tags
Q Logger1
Tag Name . Tag Name
>
4
«
Server Mame  Tag Name Description j 4
Serverl ¥ 2542-010A1-00 Desc =
Serverl ¥ 2542-00A1-01 Desc 3
Serverl ¥ 2542-00A1-02 Desc
Serverl ¥ 2542-00A1-03 Desc -

NOTE Configuration changes will be updated to Logger’s runtime service after the runtime service is started. If the
runtime service is not started, any change will be discarded when the configuration console is closed. Be
sure to save your project file when you close the configuration console.

NOTE Stopping Runtime Service will stop both the logger recording and data supplement functions, which may

cause data loss.
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Starting Recording

To start recording data, click the logger icon and then click the Start Recording icon to start recording the

selected tags into the database or spreadsheet.

& MX-AOPC UA Logger

File Server Logger Tools Runtime Help
! B J,
= ' Server Group ;.
' Server1(192. 168.127.200:53192)
[ automatically start recording when service starts running
Tag Selection I
=~ i Logger Group List | v‘ i vi [G‘
-5, LoggerGroupd=" Available Tags Selected Tags
Tag Name | » | Tag Name
I =
L
(<]
(«]
Server Mame  Tag Mame Description ]
Serverl T 2542-0LA1-00 Desc o
Serverl W 2542-0LA1-01 Desc 3
Serverl W 2542-0LA1-02 Desc
Serverl W 2542-0LA1-03 Desc -

A red light next to the logger indicates that the logger is recording.

File Server Logger Tools Runtime Help

-
L I
-
- ' Server Group Remrd\ng B
‘ Server1{192, 168.127.200:53192)
s ()
UAummaﬁcal\y start recording when service starts running
Tag Selection
(= Logger Group List | v| i 'i [C‘
s Available Tags Selected Tags
Tag Name | » | Tag Mame
=
L>
[ <]
[« ]
Server Name  Tag Name Description kot
Serverl Y 2542-01.A1-00 Desc o
Serverl Y 2542-01.A1-01 Desc 3
Serverl Y 2542-01.A1-02 Desc
Serverl Y 2542-01.A1-03 Desc -
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Click the folder icon to check if data is being recorded into the target spreadsheet.

o
File Server Logger Tools Runtime Help
| — — - = = = — 3 = o ‘ &
IEAEERNEKG 00888
1 -
=] ‘; Server Group et | 4
L Server1(192.168.127.200:53192)
Stop
| Automatically start recording when service starts running
Tag Selection
=~ Logger Group List C
&5 LoggerGroup1 Available Tags Selected Tags
5 0 Loggerl
Tag Name L Tag Mame
>
4
-«
Server Mame  Tag Name Description o
Serverl F 2542-01.AI-00 Desc U
Serverl F 2542-01.A1-01 Desc 3
Server1 % 2542-01.A1-02 Desc
Serverl § 2542-01.AI-03 Desc -
Property
Type: Excel
Cutput: C:VJsers\PubI\c\DacurnenE\Mc3(aWX&DPCchger\Logger\chger1_20180124_00533]
Table: Loggeri '

Be sure to close the target spreadsheet listed in the target root path before starting to record. If the target
spreadsheet is open, the MX-AOPC UA Logger will not be able to record data to the target file.

DO NOT open the spreadsheet while recording is under way. Doing so will cause the spreadsheet file to
become corrupted because it is in use by the MX-AOPC UA Logger service. To open the spreadsheet, stop
the MX-AOPC UA Logger’s runtime service and then click the folder icon to access the file.

Testing the Data Supplement Function

Take the following steps to test the data supplement function.

1. Insert a microSD card into your Moxa device.
2. Use IOxpress to configure the Moxa device to allocate data buffer size for network failure and to enable
connection to the MX-AOPC UA Server.

Settings Click&Go Plus Click&Go Plus Simulator Peer-to-Peer _
=i System
= Security Enable connection to AOPC Server with heartbeat interval 30 secfs)
= Network
E1fo Server Mode
B £ AOPC
(@ Single Server 1st ACOPC Server 192 . 168 . 127 . 200
=i Tag Selection
= SMNMP —~ 1] 1] 1] 1]
= Modbus/TCP Slave ® Dual Servers
=i Modbus/TCP Master Port 9900
= Serial Port () Failover
= & Data Logging
Rel 3
= Profile B
L FTP =
(= Click&Go Plus
Mote:
1. The network failure data buffer can store up to 20,000,000 records. You can enable this function on the "Data Logging = Profile”™
page.
2, The shortest interval for recording tags in the data buffer is 5 seconds.
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s [ asacons | owecorssmiew | rerorer [

= System Required external memory size: 2 GB (support microSD up to 32 GE)
= Security
= Metwork
Eio Timestamp column: @) Device local time (7) UTC and time zone

E = AORC
| Server Connection Mo, Profile Mame  Storage Max. Records  Records per File

[zl

Enable data buffer for network failures (requires 2 GB of memory) ]

= Tag Selection
£ SNMP
= Modbus/TCP Slave
= Modbus/TCP Master
= Serial Port
= = Data Logging

= Profile
= FTP Profile Settings
[ & Click&Go Pl 5
[ = Click&Go Plus Naic [] Enable at Power On
Maximum -SELZ % 10,000 records Records :I: i % 1,000 records (1 to 65; default: 1)

{Mote: Maximum records must be at least double the Records per

3. Select the checkboxes of the tags associated with the data you would like the MX-AOPC UA Server to

update.
Settings Click&Ga Plus | Click&Go Plus Simulator | Peer-to-Peer _
= System
e Select Module [al v| [ selectal || unselectal || applytoal |
=
= Network
210 1jO Type [AI
B = ACPC Slot Mo. Channel MNo. Description On Change
= Server Connection e N
B Tag Selection [Slot 00 Model: 2542] 0 Desc Disabled
SNMP [Slot 00 Model: 2543] 1 Desc Disabled
= = 23 3
1= Modbus/TCP Slave =l £ Desc Disabled
(= Modbus/TCP Master 2] 3 Desc Disabled
= Serial Port

4. 1If the cellular device’s SIM card uses a private or dynamic IP address, enable the Cellular Data Access
function. If the SIM card is using a public IP address, continue with step 5.

o ———————
£ System ) -
; General VPN Reconnection Port Forwarding DDNS Cellular Data Access
= Security
Bl & Network
£ General r Enable Cellular Data Access_l
= LAN
i Celliar P Address 12 . 168 . 12 . 113
=10
SHMP
By Port 3401
=
=1 ADPC :
= Serial Port Unigue ID i}
= Data Logging s
= Click&Go Plus Heartbeat 30

5. Update the device’s configuration.
I Moxa I0xpress - CAUsers\Public\Documents\Moxa\IOxpress)

Project Device Configuration Options Help

ml N AR £ é\

T 98 Laf6

B Sevce by e |
=22542-01 - 192.168.127.253

[Update Configuration to Device ']

Overwrite Network Setting

[an - Apply to Al
[T No. Device Name Model Mame  (Cellular) IP Address CDA IP Address MAC Address Configuration
D a 2542-01 2542 19 127.253 = 00-50-E8-5A-21-6E 254201
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6. Conduct Set Device Date & Time on the device to ensure that the device, MX-AOPC UA Server, and
MX-AOPC UA Logger are time synchronized.

Iy Moxa IOxpress —&ﬁj‘n’fn\[s Databa
Project Device Configuration Options  Help

T . @ - \i - 7
al B R O IHER™ ‘
[z =aDevice Library Deplayment
=32542-01- 192.168.127.253
[set Device Date & Time -
@ Sync with PC @ Manual Setting  Date: 2018/ 1/24 [J~ | Tine: 12:30:28 g wrcy
[an -] Apply t Al
[T No. Device Name Madel Name (Cellulzr) IP Address CDA IP Address MAC Address
] 1] 2542-01 2542 192,168.127.253 00-90-E58-5A-21-6E

7. If Cellular Data Access software is required, enable the MX-AOPC UA Logger’'s Data supplement
through Cellular Data Access option at Tools > Data Supplement Settings. If Cellular Data Access
software is not required, continue with step 8.

General Settings

Retry Tmeout 30 sec(s) (5 to 600, default: 30)
|
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network recannection
[ Data supplement on schedule

Everyday at 00:00

Data loss in the past | 1 day(s) (1 to 7, default: 1)

1 Data supplement through Cellular Data Access

IP Address B .0 .0 .0

Port 9400 {0 to 65535, default: 9400)

Folder for supplementary data
Path C:.‘i.Users.\Fui::ii.é:\bumments.‘lﬁoxawanPCL; E]
Log Folder for Data Supplement on Demand

C:.‘i.Users.\Fui::ii.é:\bumments.‘lﬁoxawanPCL;

| ok || cancl
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8. Ensure that the logger is in recording mode.

i MX-AOPC UA Logger

File 5Server lLogger Tools Runtime Help
e B —— =) B = - E ; E 1
=) u Server Group Eeredng &=
” Server1(192.168.127.200:53192) l
Start I
| Automatically start recording when service starts running
Tag Selection
=1~ &4 Logger Group List | | |
& Gl 1 Available Tags Selected Tags
Tag Name | Tag Name
E
‘ -
L]
Server Mame  Tag Name Description o
Serverl T 2542-01.A1-00 Desc D
Serverl T 2542-01.A1-01 Desc 3
Serverl Y 2542-01.A1-02 Desc
Serverl T 2542-01.A1-03 Desc -

9. Disconnect the Ethernet connection between the Moxa device and the MX-AOPC UA Server. Wait longer
than the heartbeat interval (the ioLogik 2500’s default heartbeat interval is 30 sec.) plus the heartbeat
tolerance (the MX-AOPC UA Server’s default heartbeat tolerance is 30 sec.), and then check if the tag
status is “"Disconnected” on the MX-AOPC UA Viewer. If it is disconnected, wait longer than the update
interval of the tags, and then reconnect the connection between the Moxa device and MX-AOPC UA
Server.

OIS 5 v SO T S T

File Tools Help

18 Active Device List Tag Name Description Data Type Value Device timestamp (UTC) Time Zone  UTC+T.Z. Access Rights|  Quality Update Count

Desc Float j 05:5408.000 2018/01/24  UTC+8  13:5408.000 2018/01/24  Read-only Disconnected
L3-8 Modbus Device Group List Desc Float d 05:54:08.000 2018/01/24  UTC+8  13:54:08.000 2018/01/24  Read-only Disconnected
& DeviceGroupl Desc Float g 05:5408.000 2018/01/24  UTC+8  13:5408.000 2018/01/24  Read-only Disconnected
& Devicel i 2542-01.A1-03 Desc Float i i uTC+8 ! Read-only Disconnected
& TagGroupl 25420101000 Desc Boolean 0 i uTC+8 i Read-only Disconnected
925420101001 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
25420101002 Desc Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
iy 2542-01.010-03 Boolean 05:51:08.000 2018/01/24  UTC+8  13:51:08.000 2018/01/24  Read-only Disconnected
% 2542-01.010-04 Boolean 05: L uTC+8 X Read-only Disconnected
i 2542-01.DI0-05 Boolean 05:51:08, uTC+8 :51:08. Read-only Disconnected
% 2542-01.010-06 Boolean 05: ! uTC+8 i Read-only Disconnected
i 2542-01.010-07 Boolean 05: b uTC+8 i Read-only Disconnected
% 2542-01.010-08 Boolean 05: g uTC+8 ! Read-only Disconnected
i 2542-01.DI0-09 Boalean 05: ] UTC+8 I Read-only Disconnected
% 2542-01.010-10 Boolean 05:51:08.000 2018/01/24  UTC+8 5 Read-only Disconnected
i 2542-01.D10-11 Boalean 05:51:08.000 2018/01/24  UTC+8 ] Read-only Disconnected
5 2542-01.SysConn, Boolean 05:54:58.818 2018/01/24  UTC+8 :54:58. Read-only Good
i 2542-01.5ysIPAd.. i String 16, 58,818 2018/01/24  UTC+8 i Read-only Disconnected
# 2542-01.5ysMAC String : 05:54:58.818 2018/01/24  UTC+8 58,818 2018/01/24  Read-only Disconnected

Date Event

2018/01/24 :56: The tag DevicaGroup 1. Device 1. TagGroup 1.Tag 1 changes the quality from Bad to Disconnected

2018/01/24 :54: The tag 2542-01.SysConnect-00 changes the value from 1 to 0 |
2018/01/24 The tag 2542-0 1.5ysIPAddress changes the quality from Good to Disconnected 3
2018/01/24 The tag 2542-01.5ysMAC changes the quality from Good to Disconnected

2018/01/24 The tag 2542-0 1, AI-03 changes the quality from Good to Disconnectzd

2018/01/24 The tag 2542-01. A1-02 changes the quality from Good to Disconnected

2013/01/24 :54: The tag 2542-0 1, AI-01 changes the quality from Good to Disconnectzd

2018/01/24 The tag 2542-01. AI-00 changes the quality from Good to Disconnected

2018/01/24 :54: The tag 2542-01.D10-11 changes the quality from Good to Disconnected

2018/01/24 The tag 2542-01.D10-10 changes the quality from Good to Disconnected

an‘mmw 4 The tan 2547-01.010-04 channes the auality from Goad tn Nisronnected 2
“ [ *
Ready Time: 13:57:15
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10. The pink and gray flashing light indicates that the logger is performing the data supplement process.

18 axaorc ua oooe S
i Eile Server Logger Tools Runtime Help _
CEFBPERNSRHTO0SH A

= - Server Group
ﬁ Server1(192.168.127.200:53192)

Recording
| sart | [L.sep.

[] automatically start recording when service stari
Tag Selection

=& Logger Group List | v| |
Bﬁ LoggerGroupl Available Tags
i Logger1

|| Tag Name

11. After the data supplement process is complete, the light will change to red. The event log will show how
long the data supplement process took to perform, and the result of the supplement process.

1

i MX-AOPC UA
Server Logger Tools Runtime Help )
: — - = = 5 = -
TR PERODERT 008888
=5 ' Server Group EECTEa E
Server1{192.168.127.200:53192) _
" o Cm) |
[] Automatically start recording when service starts running
Tag Selection
=~ &4 Logger Group List ‘ T | | i | E' 3
= a LoggerGroupl Available Tags Selected Tags
4G Loggerl —_—
Tag Mame [ » | Tag Name
>
(<] B
(«]

Server Name  Tag Name Description B

Serverl “ 2542-01.A100 Desc @

Serverl W 2542-0LA101 Desc

Serverl  2542-01.A1-02 Desc

Serverl T 2542-01.A1-03 Desc - L
Date Time Event -
2018/01/24 13:53:44 Data supplement (Auto) end.
2018/01f24 13:59:44 Finished retrieving log [from 2018/01/24 05:54:58 to 2018/01,/24 05:58:41] from the device [MAC:00-90-e8-5a-21-6e].
2018/01f24 13:59:42 Retrieving log 11 [from 2018/01/24 05:54:58 to 2018/01/24 05:58:41] from the device [MAC:00-30-e8-55-21-6¢]
2018/01f24 13:59:42 Connecting to the device [MAC:00-90-e8-5a-21-6e] for retrieving log from 2018/01/24 05: 54: 58 to 2018/01/24 05:58:41...

1581 Trying to connect to the device,
2018/01f24 13:58:44 Data supplement (Auto) begin,
2018/01f24 13:52:02 Data supplement (Auto) end.
2018/01f24 13:52:02 Finished retrieving log [from 2018/01/24 05:02:33 to 2018/01,/24 05:50:58] from the device [MAC:00-90-e8-5a-21-6e].
2018/01f24 13:52:00 Retrieving log 11 [from 2018/01/24 05:02:33 to 2018/01/24 05:50:58] from the device [MAC:00-90-e8-55-21-6e] =
;nl_n,.__."_ PR = o o a EE s S AL T .| R e L R R R A .
Service Status : Running Time: 14:00:04 Data Supplement Queue: 0000

12. Open the database folder and note which files the supplementary data has been saved to.

. v Computer » Windows7_05 (C:) » Users » Public » Documents » Moxa » MXAOPCLogger » DataComplement » 00-90-e8-5a-21-6e

Organize « Open ~ Share with + Print Mew folder

-

< Favorites MName Date modified Type Size
‘E_-:_| Recent Places 2018-01-24-04-50-08_2018-01-24-05-52-08.csv 2018/1/24 F5 01:... Microsoft Excel C... 58 KB
8 Downloads 2018-01-24-04-50-08_2018-01-24-05-59-48.csv 2018/1/24 F5 01:...  Microsoft Excel C... 66 KB
3 Dropbox | 2018-01-24-04-50-08_2018-01-24-06-45-58.csv 2018/1/24 T 0. Microsoft Excel C... 109 KB
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Testing the Data Supplement on Demand
Function

Take the following steps to test the data on demand function.

1. Ensure the logger is in recording mode.

&1 MX-AOPC UA
File Server Logger Tools Runtime Help
r = 4 3 = e = - - - B
DCEFEEBRBOSREHO0OSEH4EE
= | Server Group Recording =
Server1{192,168.,127.200:53192) _
. S|
[] Automatically start recording when service starts running
Tag Selection
=8 Logger Group List | '| | " !C|
B"' b Available Tags Selected Tags
Tag Mame | » | Tag Name
L)
L]
[«]
Server Mame  Tag Name Description =
Serverl g 2542-00A100 Desc E
Serverl g 2542-0LA101 Desc 3
Serverl Y 2542-00.A1-02 Desc
Serverl g 2542-01A103 Desc -

2. Click the Stop Recording button to stop recording data, and then wait.

M¥-AOPC UA
File Server Logger Tools Runtime Help

TEEBEBRNSKG008ES S

= ﬂ Server Group Recording
5 Server1{192,168.127,200:53192)
| st |fl swe |

["] Automatically start recording when service starts 1
Tag Selection

E|§;j Logger Group List | E | |
Elﬁ i iy Available Tags

ﬁ Loggerl

Tag Mame
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Getting Started

Click Logger Group List and then click the Data Supplement on Demand button. The default on-
demand period is one day in the past.

£ MX-AOPC UA Logger =[] =

File Server Logger JTools Runtime Help

TR EERENIRG 0088

= ‘ Server Group
- [ Server1(192,168.127.200:53192)

StartDate: 1/23/2018 v  StartTme (UTC):  7:36:35AM 2] %;%Eﬁ%-’ﬁ

EndDate:  1/24/2018 = End Time (UTC): ~ 7:35:35 AM @ Refrieve Close

Log Folder:  C:\Users\Public\Documents Moxa MXAOPCLogger\Logger_on_Demand E
Timeout: 30 sec(s); Retries: 3 tme(s)
[

Start Date Start Time End Time

Date Time Event

2018/01/24 15:34:31 Stop recording logg

< 1

Service Status : Running Time: 15:36:51 Data Supplement Queue: 0000

Click the Retrieve button to start retrieving lost data in the defined period. The pink and gray flashing
light indicates that the logger is performing the data supplement process.

£ MX-AOPC UA Logger == =

File Server Logger Tools Runtime Help

TEARERNIRGO0S88S

=5 B Server Group
- [ Server1(192.168.127.200:53152)

S —

Current Time (UTC):
2018/01/24 07:17:35

StartDate:  1/23/2018 = Start Time (UTC):  7:14:51 AM E

[=- &4 Logger Group List

SEFEPETEHD —_ —
@ Loggert EndDate:  1/24/2018 ~ EndTime (UTC):  7:14:51 M [ =] | Retrieve Close
Log Folder:  C:Wsers\Public\Documents\Moxa \MXAOPCLoggerLogger_on_Demand E]
" Timeout: 30 sec(s); Retries: 3 time(s)

Start Date Start Time End Date End Time Result
2018/01/23 07:14:51 2018/01/24 07:14:51 Retrieving

I
I
il Date Time &
Wl 2018/01/24 15:17:35 £
Wl 2013/01/24 15:17:18
2013/01/24 15:17:03 130124_005331\Logger1_201801
2013/01/24 15:17:.02 180124_005331\Logger1_201801
2018/01f24 15:17:01 Retrieving log 13 [from 2018/01/23 07:14:51 to 2018/01f24 04:27:37] from the device [MAC:00-00-e8-5a-21-6e]
2018/01f24 15:17:01 LoggerGroup 1.Logger 1: supplement data is saved to C:\Users\Public\DocumentsMoxa MXAOPCLogger\Logger\Logger 1_20180124_005331\Logger1_201801
2018/01f24 15:17:01 Connecting to the device [MAC:00-90-e8-5a-21-6¢] for retrieving log from 2018/01/23 07:14:51 to 2018/01/24 04:27:37...
2018/01f24 15:17:01 Trying to connect to the device,
2018/01f24 15:17:01 Data supplement (Demand) begin. =
;Tnmm T o it e 3
Service Status : Running Time: 15:17:36 Data Supplement Queue: 0000
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5.

6.

Once the retrieving process is finished, the Result column will show Complete.

[=]  Current Time (LTC):
StartDate:  1/23/2018 Start Time (UTC):  7:18:17 AM
i b ™ L bt (1] =1 2018/01/24 07:18:20

End Date: 1/24/2018 = EndTime (UTC):  7:18:17AM || | Retieve || Close |
Log Folder:  C:'Wsers\Public\DocumentsMoxaMXACPCLogger\Logger_on_Demand [ ]
Timeout: 30 sec(s); Retries: 3 time(s)
Start Date Start Time End Date End Time Result
2018/01/23 07:14:51 2018/01/24 07:14:51 Complete

To check detailed information, see the Log View at the bottom of the screen.

s .. W DT
File Server Logger Tools Runtime Help
Q08885 .

SE NI

|
I =5 ‘ Server Group i
| - [ Server1{192.168.127.200:53192)
|
=8 Logger Group List
=5 LoggerGroupl
@) Loggerl
Date Time Event =
2013/01/24 15:18:07 Data supplement (Demand) end.
2018/01/24 15:18:06 Finished retrieving log [from 2018/01/24 06:45:59 to 2018/01/24 07: 14:50] from the device [MAC:00-20-e8-5a-21-6e]. =|
2018/01f24 15:18:05 LoggerGroup 1.Logger 1: supplement data is saved to C:Ysers\Public\Documents\Moxa MXACOPCLogger\Logger Logger 120180124 005331 oggerl 201801
2018/01f24 15:17:53 Retrieving log 1/1 [from 2018/01/24 06:45:59 to 2018/01/24 07: 14:50] from the device [MAC:00-30-e8-5a-2 1-6e]
2018f01f24 15:17:52 Connecting to the device [MAC:00-20-e5-5a-21-6€] for retrieving log from 2018/01/24 06:45:52 to 2018/01/24 07: 14:50.,..
201801f24 15:17:52 Mo data found [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-90-e8-55-21-6e] for supplement,
2018/01f24 15:17:35 Retrieving log 3/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-30-e8-55-21-6&]
2018/01f24 15:17:18 Retrieving log 2/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-30-e8-55-21-6&]
2018/01f24 15:17:03 LoggerGroup 1.Logger 1! supplement data is saved to C:\Users\PubliciDocumentsMoxa MY AOPCLogger\LoggerLogger1_20180124 005331\ oggerl_2015801
2018/01/24 15:17:02 LoggerGroup 1.Logger 1: supplement data is saved to C:Users\Public\DocumentsMoxa MY AOPCLogger \Logger YLoggerl_ 20180124 005331 oggeri_2015801
2018/01f24 15:17:01 Retrieving log 1/3 [from 2018/01/23 07:14:51 to 2018/01/24 04:27:37] from the device [MAC:00-80-e58-53-21-6e]
2018/01f24 15:17:01 LoggerGroup 1.Logger 1: supplement data is saved to C:Users\Public\DocumentsMoxa MXAOPCLogger \Logger Loggerl_ 20180124 005331 oggeri_2015801
2018/01f24 15:17:01 Connecting to the device [MAC:00-30-e8-5a-21-6¢] for retrieving log from 2018/01/23 07: 14:51 to 2018/01/24 04:27:37...
201801f24 15:17:01 Trying to connect to the device.
2018/01f24 15:17:01 Data supplement (Demand) begin. E
P — i B v
Service Status : Running Time: 15:19:34 Data Supplement Queue: 0000
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Testing the Data Supplement on Schedule
Function

Take the following steps to test the data on demand function.

1. Ensure that the runtime service is NOT in run mode.

File Server Logger Tools Runtime Help

{".
& mron e T S S

B ELI 1L LI R IC G EEEE

II 5 Server1{192,168,127,200:53192)

= ' Server Group ‘ ‘

2. Click Tools > Data Supplement Settings.

"
T e oreun o S

File Server Logger IIor.:-Is Buntime Help

A — Data Supplement Settings | ;

Certificate Management

[ Server Grou
III ‘ : Systern Log 3

------- B Server1(19

Change Password

Options

=8 Logger Group List
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3. Enable the Data supplement on schedule function, set the time (UTC Time) to a few minutes later
and data loss in the past to 1 day.

ouasppeners ey

I General Settings
Retry Timeout 30 sec(s) (5 to 600, default: 300
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network reconnection
Data supplement on schedule

Everyday at 13:15 El (UTC time)

Data loss in the past 1 day(s) (1 to 7, default: 1)

Data supplement through Cellular Data Access

IP Address c .0 .0 .0

Port |9400 (0 to 65535, default: 9400)

Folder for supplementary data

Path C:\Users\Public\Documents\Moxa MY ADPCL E]

Log Folder for Data Supplement on Demand

C:\Users\Public\Documents Moxa \MXACPCL 1

Lok J[ concel |

4. Start the run time service.

oy
File Server Logger Tools Runtime Help
BEETTT YL T ICGCERIEE

B ' Server Group
| g Server 1{192. 168. 127.200:53192)

Recording

[ sart || swp |

|
Automatically start recording when service starts running
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5. Start recording the logger.

s wcsorc oo S
I __Eile Server I__ogger__ Tools Runtime Help

S . e

EEE L

B ' Server Group
[ Server1(192.168,127,200:53192)

CERENS& G00[S

Recording

[] automatically start recording when service starts running

Tag Selection
| ] | -] le)
Available Tags Selec
‘ Tag Mame i L | Tag
Mu 1

6. When the specified time elapses, the data supplement on schedule function will be triggered. The
progress will be displayed in the Log View as shown below.

: T
(4 wesore ua oo I = =
([File sever logger Tools Runtme Help
o am e | - - = = 2 -
ITERPERONIEKEHO08 48
E|' Server Group Recorin B

o [ Server1(192.168,127.200:53192) (e
(st ] (see)

»

[ Automatically start recording when service starts running

Tag Selection
BE Logger Group List | v| | - ‘ | G| H
B- ﬁ L‘{QQE’G"’“D]- Available Tags Selected Tags
e
Tag Mame Tag Name

Ml

Server Name  Tag Name Description
Serverl % 2542-01.A1-00 Desc
Serverl % 2542-0LA1-01 Desc
Serverl W 2542-01.A1-02 Desc
Serveri “ 2542-01.A1-03 Desc

Date Event
—

2018/01/28 Data supplement (Schedule) end.

2018/01/28 Finished retrieving log [from 2018/01/28 10:19:54 to 2018/01/28 10:20:53] from the device [MAC:00-90-e8-55-21-6¢].
2018/01f28 Retrieving log 1f1 [from 2018/01/28 10:19:54 to 2018/01/28 10:20:59] from the device [MAC:00-90-e8-53-21-6e]
2018/01f28 Connecting to the device [MAC:00-90-e8-5a-21-6e] for retrieving log from 2015/01/28 10:19:54 to 2018/01/28 10:20:55...
2018/01/28 Finished retrieving log [from 2018/01/27 10:21:00 to 2018/01/28 10:16:40] from the device [MAC:00-290-8-5a-21-6].
2018/01/28 LoggerGroup 1.Logger 1: supplement data is saved to C:\Users\Public\DocumentsMoxa\MX AOPCLogger\Logger\Logger 1_20180124_005331\Logger
2018/01/28 Retrieving log 1/1 [from 2018/01,/27 10:21:00 to 2018/01,28 10:16:40] from the device [MAC:00-90-28-5a-21-6¢]
2018/01/28 Connecting to the device [MAC:00-90-e8-5a-21-6e] for retrieving log from 2018/01/27 10:21:00 to 2018/01/28 10:16:40...
2018/01/28 Trying to connect to the device.

2018/01/28 Data supplement {Schedule) begin.

2018/01f28 Start recording all logger

< [}

Service Status : Running Time: 18:22:27 Data Supplement Queue: 0000
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Configuration Console

The following topics are covered in this chapter:

O Main Screen Overview
O Menu Items
> File
Server
Logger
Tools

Runtime

vV V VYV V V

Help
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Main Screen Overview

The MX-AOPC UA Logger’s configuration console displays settings for connected MX-AOPC UA Servers and
loggers. It also shows the logger runtime status.

2 MX-AOPC UA Logger p=elEl

TEREEBENERG 0088 SE -

=23 ﬁ Server Group Recording =
I - ﬁ Server1{192. 168. 127, 200:53192)
Start Stop
4 || Automatically start recording when service starts running
Tag Selection
-8 Logger Group List [Seruerl v] |iAll Device '] =
BE LoggerGroupl Available Tags Selected Tags
LR L 1
ﬁ —— Tag Name il » Tag Name =
L DeviceGroupl.Devicel.TagGroupl.Tal—l E] %% 2542-01,A1-00 |i|
W E2242-01.A1-00 E T 2542-01.A1-01
W £2242-01.A1-01 W 2542-01.A1-02 |
Ty E2242-01.A1-02 - E W 2542-01.A1-03
o m i 2542-01.010-00 -
5
Server Mame  Tag Mame Description i
Serverl ¥ 2542-01.A1-00 Desc [l
Serverl W 2542-01.A1-01 Desc
Serverl ¥y 2542-01.A1-02 Desc
Serverl W 2542-01.A1-03 Desc -
Date Time Event
20180123 16:47:47 MX-ACPC UA Logger runtime service is stop.
2018/01f28 16:33:13 Auta reconnect to Server1 success! (Service)
2018/01/26 23:14:33 Initializing database...
2018/01f25 23:14:33 LoggerGroup 1.Logger1is invalid. No tag is selected.
2018/01f26 23:14:30 MX-AQPC UA Logger runtime service is running. 7
4| m 2
Service Status : Stopped 8 Time164931 9 Data Supplement Queue: 0000 10
No. |Zone Description
1 Software Title Displays the name of the software: MX-AOPC UA Logger
2 Menu Bar All configuration functions can be accessed from these menu items
3 Quick Launch Bar Frequently used icons
4 Server View All MX-AOPC UA Servers
5 Logger View All Loggers
6 Detailed View Detailed settings of the servers and loggers
7 Log View Logger Runtime logs
8 Runtime Service Status Indicates if the logger runtime service is Running or Stopped
9 Logger Time Displays the Logger time (same as the PC’s time)
10 Data Supplement Queue Displays the data supplement waiting items in the queue
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Menu Items

File

Use the File menu to manage project files.

i MX-AOPC UA Logger - D:‘h.charleﬂ{_chen‘a[}nulmenis_ue_m_ A
[Eile] Server Logger Tools Runtime Help

Mew Ctrl+M :! &
Open.. Ctrl+0 .

Save Ctrl+5

Save As..,

1 AOPC_Loggers.aog
2 A0OPC_Loggerd.acg
3 AOPC_Logger3.aoyg
4 AOPC_Logger2.aog
5 AOPC_Loggerl.aog

Exit

e New: Create a new project file.

e Open: Open an existing project file.

e Save: Save the current project.

e Save As: Save the current project file as another project with a different filename.
* Previous saved files: Quickly open previously saved project files.

e Exit: Close the Configuration Console.
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Configuration Console

Server

Use the Server menu to edit MX-AOPC UA Server connection settings.

£ wca0vc U Loga A

File [Sewer] Logger Tools Runtime Help

Discovery
Connect
Disconnect

Delete

Properties

112:53197)

= §:i' Logger Group List

ERSE&

¢ Discovery: Discover MX-AOPC UA Servers and configure its connection settings.

e Connect: Connect the selected server.

e Disconnect: Disconnect the selected server.

e Delete: Delete the selected server.

¢ Properties: Modify the settings of the selected server.

NOTE

The properties of a server cannot be modified either when the server is in connecting mode, or runtime
service is in running mode. Stop runtime service and disconnect the server connection before modifying the

server properties.
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Logger

Use the Logger menu to edit logger settings.

,

Eile 5Server [Lﬂgger] Tools Runtime Help

Y u—— Mew Logger Group a;
Mew Logger Bl
Delete

Start Recording
Stop Recording

Drata Supplement on Demand

Termninate Data Supplement

Properties

e New Logger Group: Create a new logger group.

e New Logger: Create a new logger.

o Delete: Delete the selected logger.

e Start Recording: Start recording for a selected logger group or a selected logger.
e Stop Recording: Stop recording for a selected logger group or a selected logger.

o Data Supplement on Demand: Retrieve lost data during a specified period. Refer to Testing Data
Supplement on Demand in Chapter 2.

e Terminate Data Supplement: Terminate all of the data supplement waiting items in the queue.

¢ Properties: Modify the settings of an existing logger.

NOTE The properties of a logger cannot be modified either when the logger is in recording mode, or runtime
service is in running mode. Stop runtime service before modifying logger properties.
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Tools

Use the Tools menu to configure data supplement settings, for certificate management, to access a system
log, to change a password, or to modify console environment settings.

5 wixcAoPC Ua Loso=

File Server Logger | Tools | Runtime Help

e N Diata Supplement Settings ! @

LES B .

8- ﬁ Server Group

Certificate Management

Systern Log [
Change Password

Options

=™ =8| cgoer Group List
B

e Data Supplement Settings

o Sppenes e

I General Settings
Retry Timeout 30 : sec(s) (5 to 600, default: 300
Retries 3 {0 to 10, default: 3)
Triggering Event

Data supplement after network reconnection
[ | pata supplement on schedule

Everyday at 00:00

Data loss in the past 1 I day(s) (1 to 7, default: 1)

[ | Data supplement through Cellular Data Access

IF Address RS | TR

Port |9400 {0 to 65535, default: 9400)
Folder for supplementary data

Path C:\Users\Public\Documents\Moxa MXACPCL: E]

Log Folder for Data Supplement on Demand

E:‘l.l_Jsers\FuEiic\DnmmentsanaWADPCLI- 1

| ok || cancl
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» General Settings:

] Retry Timeout: The retry timeout interval for retrieving supplementary data from a device’s
buffer.

] Retries: The number of retries allowed after a retry timeout.

> Triggering Event: Enable the following functions if the Moxa products connected to an MX-AOPC UA
Server supports the data supplement function.

] Data supplement after network reconnection: Enable data supplement function after
network reconnection.

] Data supplement on schedule: Enable data supplement function on schedule at the specified
time. The triggering time can be set to everyday at a specific time. The data loss period can be
set to 1 to 7 days in the past.

> Data supplement through Cellular Data Access: Enable this function if the Moxa products
connected to the Cellular Data Access software support the data supplement function.

= IP Address: The IP address of the Cellular Data Access software.
] Port: The listen port of the Cellular Data Access software.
> Folder for supplementary data

] Path: The folder path to which the system can temporarily save supplementary data. Click

(|

Iil to change the folder path. Click l—l to open the folder. Delete the supplementary
data files after the data is written to the database.

> Log Folder for Data Supplementary on Demand

] Path: The folder path to which the system can temporarily save the log files of the

supplementary data on demand. Click Iil to change the folder path.
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Configuration Console

Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsa15: Sign, Basic128Rsa15: Sign
and Encrypt, or both, importing an OPC UA client’s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC
UA Logger. Click Export to export the selected certificate. Click Remove to remove the selected
certificate. Click Trust to trust the selected certificate. Click View Certificate to view the selected

certificate.

Trust Servers | Instance Certiﬁmtes|

Server Mame

v MX-AQPC LA Server

URI
urn: CHARLESCHEM-ME:MxX-AQPC LA Server

T | P

Import... Export...

Remove | Trust ' | View Certificate. ..
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Click the Instance Certificates tab and click Export Logger Certificate to export the MX-AOPC UA
Logger’s CA file to OPC UA Server.

Cenifcate: Menagermer ——
Trust Servers | Instance Certificates |

| View Logger Certificate... | Certificate MX-AQPC UA Logger is from
1/9/2018 4:24:45 PM to 12/14/2022
4:24:45 PM

[ Export Logger Certificate... ]

[ Reissue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.

e System Log

£ Mx-A07C UA Logs T

File Server Logger | Tools | Runtime Help

/= 'E m-— Data Supplement Settings ] ﬁ @ 6 . :
- Certificate Management : @ &;
|
& Server Grou
ﬁ g System Log r Save to Text File

Change Password HESER Syiem Fog

Options !
= & e |

> Save to Text File: Save the MX-AOPC UA Logger’s system log to a text file. You will be required to
enter a password (default password = moxa).

Verify Password . g

System Log Settings

Please enter password;:

| [DK][CWE'H
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» Reset System Log: Reset the MX-AOPC UA Logger’s system log. You will be required to enter a
password (default password = moxa).

MX-AOPC UA Logger [ ]

Verify Password u

; lj Do you want to reset system log?

Flease enter password:

[ yes ] ’ b [ Ok, ][ Cancel

» System Log Settings: Defines the maximum number of records that can be saved in the MX-AOPC
UA Logger’s system log (values can range from 1 to 30000; the default value is 30000).

System Log Settings - u

Event Records: 30000 {1~30000)

| ok || cancel |

e Change Password: Change the MX-AOPC UA Logger’s system password. The password is required
when updating configurations to System Runtime, saving system logs to a text file, or resetting the
system log (length: 4 to 128; acceptable characters: A to Z, a to z, 0 to 9, Symbols; default: moxa).

Old Password:

Mew Password:

Confirm Password;

[ ok || cancel |

e Options: Configure environment settings for the MX-AOPC UA Logger’s configuration console.

opi T

Configuration File

Automatically save configuration every 10 = min{s) (1 to 30, default: 10)

Automatically save configuration before exiting this console

[ Ok, ] [ Cancel

NOTE If Automatically save configuration every xx min(s) is enabled, the configuration file will be
automatically saved only when a filename is defined. Be sure to save your configuration file after creating a
new project file.
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Runtime

Use the Runtime menu to Start, Stop, or Reinitialize Server Runtime Service.

& MX-A0PC UA Logger I

File Server Logger Tools !Euntime Help

P _. - ‘ ﬁ Start Runtime Service ﬂ

e Stop Runtime Service

& ﬂ Server Group Reinitialize Runtime Service
------- ﬁ Server1(192. 168, 12 TT53197) |

Help

Use the Help menu to launch the Logger’s help documentation, to check the Logger’s license status, to add
a license file, or to check the logger version.

T E——

File Server Logger Tools Runtime Help
- _. P ‘ ﬁ ﬁ ﬁ Logger Help ‘
- Licensing L
- ﬁ Server Group About...

------- ﬁ Server1{192.168.12,112:53192] | I

Start

e Logger Help: Launch the MX-AOPC UA Logger’s help documentation.
e Licensing

File Server Logger Tools Runtime ETIP‘]
F = —- —— ‘ ﬁ ﬂ j Logger Help N =
s Licensing r License Info

= a Server Group About... Add License File
------- B Server1(192.168.12.112:53192) ‘ |

Start Deactivate License

> License Info: Displays the Logger’s User Code, License Status, and the Time Remaining on the
license. Refer to License Registration and Activation to learn how to activate the license.

e e

User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1
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» Add License File: Import a license file after completing the license registration process. Refer to
License Registration and Activation to learn how to activate the license.

> Deactivate License: Deactivate the current paid license version and load factory default settings.
Note that when you deactivate the license, your license file and runtime configurations will be

deleted. Be sure to back up your runtime configurations before executing a license deactivation
procedure.

e About: Displays the MX-AOPC UA Logger’s version nhumber and build number.

- e
Moxa MX-AQPC LA Logger 1.0 build 16040818

g._! Copyright (C) 2016 Maxa Inc.
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Server Management

The following topics are covered in this chapter:

0O Server Discovery
> Getting the Server Endpoint from an MX-AOPC UA Server
» Discovering MX-AOPC UA Servers
O Server Connection
» Connecting to the discovered MX-AOPC UA Server
> Editing the connection settings of the discovered MX-AOPC UA Server
» Deleting the connection settings of the discovered MX-AOPC UA Server
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Server Discovery

In this section we explain how to discover an MX-AOPC UA Server.

An MX-AOPC UA Logger can discover MX-AOPC UA Servers installed on a local or remote computer. First,
get the server endpoint, and then follow the onscreen instructions to discover the server. After the server
has been discovered, be sure to connect to the server before adding the tags into loggers for recording.

NOTE The server discovery or server connection settings can only be configured when runtime service 0
status is stopped. To stop the runtime, click the stop runtime icon on the quick launch bar.

Getting the Server Endpoint from an MX-AOPC UA Server

1. Open the MX-AOPC UA Server configuration console by clicking Tools > OPC UA Settings > Server
Endpoint Settings. Be sure the status of the Server Endpoint is valid, and then copy the Server Endpoint
of the MX-AOPC UA Server.

Server Endpoints Settings H_E-J

URL Status
opc. top: /192, 168, 12, 112:53192MXACPC UAServer Valid

Metwork Interface: | Intel(R) Ethernet Connection (3) I215-1M b

Port Mumber: 53192

opc.top: /192, 168. 12, 112: 53192/MXAQPC UASErver

| Add I I Delete | | Apply I [ Close

2. Go to Tools > OPC UA Settings > Security Policy Setting and confirm the MX-AOPC UA Server’s
security policy settings. The security policy is applied to connections between OPC UA clients and the MX-
AOPC UA Server. If Basic128Rsal5: Sign, Basic128Rsal5: Sign and Encrypt, or both of these options are
selected, you will need to configure Certificates Management settings on both MX-AOPC UA Server
(Tools > OPC UA Settings > Certificates Management) and MX-AOPC UA Logger (Tools >
Certificate Management). If only "None” is selected, you only need to know the password of the MX-
AOPC UA Server.

Security Policy Setting [ ]

MNone
[ Basic128R=a15 - Sign

___ Basic128R:=a 15 - Sign and Encrypt

(5]4 ] [ Cancel
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Discovering MX-AOPC UA Servers

1. Go to the MX-AOPC UA Logger, right click a Server Group and then click Discovery in the pop up menu,
or click the Server Group to select it and then click the Discovery icon on the quick launch toolbar to start
discovering MX-AOPC UA Servers.

, e

Eile Server Logger Tools Runtime Help

ERESEH&GO0&E

....... .
Discovery

2. Select Local Server if the MX-AOPC UA Server and MX-AOPC UA Logger are installed on the same
computer, or click Remote Server Endpoint and type in the target Server Endpoint. Next, type in the
password of the MX-AOPC UA Server, and then click the Next button.

S ==

@ Local Server

| ope. tcp://192. 168. 12. 112:53192/MXAOPC/UAServer -

") Remaote Server Endpoint

Password bbbl

<gack || Next> | [ cancel
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3. Modify Server Name, and configure Security Policy and Security Mode to be the same as the MX-
AOPC UA Server’s UA Settings. If necessary, update the Publish Interval, Sampling Interval, Queue
Size, or Discard Oldest settings, and then click Finish.

Discovery Server Lﬁ]

Server Mame  Serverl (max. length = 30; " is not allowed)

Server Endpoint:  opc.top: /192, 168. 12, 112: 53192 MXAOQPC fUASErvEr

Security Palicy [Nnne - ]

Security Mode INnne - I

Subscription Settings

Publish Interval 1000] — me (0 to 85400000, default: 1000)

Keep Alive Count 10
Lifetime Count 1000
Maonitored Item Settings

Sampling Interval 500 : me (-1 to 86400000, default: 500)
Queue Size 10 (0 to 10000, default: 10)

Discard Oldest [

< Back H Finish ]| Cancel

> Server Name: Give a name for the connection of the MX-AOPC UA Server (max. length = 30; a
period “.” is not allowed). The server name should be unique and cannot be modified after you click
Finish.

Server Endpoint: The server endpoint of the discovered MX-AOPC UA Server.

Security Policy: Configure the same security policy as the MX-AOPC UA Server.

Security Mode: Configure the same security mode as the MX-AOPC UA Server.

YV V V V

Subscription Settings: Configure the subscription settings for MX-AOPC UA Logger to receive OPC

tag data from the MX-AOPC UA Server.

= Publish Interval: The publish interval defines the rate at which the Server sends OPC tag data
to the Logger (unit: ms; values: 0 to 86400000; default: 1000; 0: the fastest practical rate).

= Keep Alive Count: The keep alive count defines the number of publish intervals that must
expire before a keep alive message is sent to MX-AOPC UA Server.

] Lifetime Count: The lifetime count defines the number of times of publish interval can expire
without the MX-AOPC UA Logger sending data updates or keep alive messages before the server
deletes the subscription.

> Monitored Item Settings

= Sampling Interval: The sampling interval defines the rate at which the server checks for
changes in the monitored device readings (unit: ms; values: -1 to 86400000; default: 500; the
default interval set by the server: -1; the fastest practical rate: 0).

. Queue Size: The queue size defines the number of data updates that the OPC UA Server will
queue for the subscription
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. Discard Oldest: The discard oldest defines the discard policy of the queue. When checked, the
oldest notification in the queue will be discarded and will not be sent to the MX-AOPC UA Logger.
When unchecked, the latest notification will be discarded and will not be sent to the MX-AOPC UA
Logger (default setting: enabled).

Server Connection

In this section we explain how to connect to the discovered MX-AOPC UA Server, and how to modify the
connection settings.

Connecting to the discovered MX-AOPC UA Server

Before configuring the logger, you must first connect to the discovered MX-AOPC UA Server to get the OPC
tag list from the servers.

1.
2.

Ensure the runtime service is stop.
Right click the server and click Connect in the pop up menu, or click the server to select it and then
click the Connect icon on the quick launch toolbar. The server should now be connected to the MX-AOPC
UA Logger.
EEIT=s . )
File Server Logger Tools Runtime Help

ey
h g iR ‘ ﬁ

ERONSKG 008884
- [ Server Group

‘ Server1(192.168.127.200:53192)

Server Endpoint: opc. tp: /{192, 168, 127, 200: 53192 MXAOPC fUAServer

Connect
Disconnect Security Policy: Mone
Delete Security Mode:  MNone

=1~ B4 Logger Group List p =

B--E LoggerGroupl R Subscription Settings Monitored Item Settings
- ﬁ- Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
Date Time Event
4 | . :
Service Status: Stopped [ Tirne: 18:38:41 Data Supplement Queue: 0000

W'
ICTERBPERNIEKF00IEH S

= B Server Group ‘ ‘

@ Serveri(192.168.127.200:53192)

Server Endpoint:  opc.top: /{192,168, 127, 200: 53192 MXAOPC /UAServer

Security Policy: MNone
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Editing the connection settings of the discovered MX-AOPC
UA Server

Take the following steps to edit the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.

2. Right click the server and click Disconnect in the pop up menu, or click the server to select it and then
click the Disconnect icon on the quick launch toolbar.

(7 : ==
T
Eile Server Logger Tools Runtime H

-

elp
-— . o T I g _ = g =
TR A BEBENISRET 008848
Bg Server Group
5 Server1(192.168.127,.200:53192) Server Endpaint: opc. top: [{192, 168,127, 200: 53192 /MXACQPC /UAServer

Connect
T Security Policy: Mone
Delete Security Mode: Maone
L Gi List L
8 H il Properties
EE LoggerGroupl Subscription Settings Monitored Item Settings
-4 Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

Date Time Event

2018/01/28 18:45:40 Connect to Server1 success!

| 1 b

Service Status : Stopped Time: 18:48:44 Data Supplement Queue: 0000

3. Right click the server and click Properties in the pop up menu, or click the server to select it and then
click the Properties icon on the quick launch toolbar. Follow the onscreen instructions to edit the
settings.

BEELLL L EICCEEEE:

= ﬂ Server Group

B -Jcerveri(192.168.127.200:53192) Server Endpoint:  ope. tep://192. 168. 127. 200: 53192 MXAOPC/UASErver
Connect
2 Security Policy: Maone
Disconnect
Delete Security Mode: Mone
= Logger Group List
E-&F LoggerGroupl Einpeite: Subscription Settings Monitored Item Settings

Publish Interval: 1000 ms Sampling Interval: 500 ms

-#g Logger1 ‘ |

NOTE The server name cannot be modified after the initial setting. To change the server name, delete the original
server settings and then use the server discovery process to create a new one. Note that deleting the server
connection settings will delete all of the related logger settings at the same time.
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Deleting the connection settings of the discovered MX-AOPC
UA Server

Take the following steps to delete the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.

2. Right click the server and click Delete in the popup menu, or click the server to select it and then click
the Delete icon on the quick launch toolbar.

File Server Logger I_ooks Runtime ﬁ_elp

O EHE BEBRNEKGO008EE8S

=5 ‘ Server Group

Server1(192. 168.127.200:53182) Server Endpoint:  opc.tep: /{192, 168, 127.200: 53192/MXAOPC/UAServer

Connect
Do connect Security Policy: Mone
Delete Security Mode: Mone

=i Logger Group List z X

=k ﬁ LoggerGroupl RS ubscription Settings Monitored Item Settings
ﬁ Logger1
Publish Interval: 1000 ms Sampling Interval: 500 ms
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest: Yes
Date Time Event
<[ [ 3
Service Status : Stopped Time: 18:52:13 Data Supplement Queue: 0000

3. Click OK to confirm that you would like to delete logger settings at the same time.
wcacre vatoose s

Deleting this server endpoint will delete all of the related logger settings at the
same time. Do you want to delete this server endpoint?

| ok || Cancel
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Logger Management

The following topics are covered in this chapter:

O Logger Group
» Adding a Logger Group to a Logger Group List
» Editing a Logger Group
> Deleting a Logger Group
O Loggers
» Adding a Logger to a Tag Group
» Editing a Logger
» Deleting a Logger
O Logger Recording
» Select Tags for Recording
» Start or Stop Recording
» Logger Status
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Logger Group

In this section we explain how to use the configuration console to add, edit, and delete logger groups.

Adding a Logger Group to a Logger Group List

1. Ensure that the runtime service is stopped.

2. Right click the Logger Group List and then click New Logger Group in the popup menu, or click the
Logger Group List to select it and then click the New Tag Group icon on the Quick Launch toolbar.

A e — = 5 = = = = =
BLENY Y G L EICGY R

=5 B Server Group
‘. [ Server1(192.168.127.200:5312)

e =8| ogoer Group List|
Mew Logger Group

Start Recording

Stop Recording

Date Time Event
< [ T F
Service Status : Stopped Time: 18:55:07 Data Supplement Queus: 0000
3. Type in the name of the logger group (max. length = 30 characters; “.” is not allowed) and then click
OK.

oo rup Propey S

Logger Group Mame LoggerGroupl

{max. length = 30; *."is not allowed)

Lo | [ concel |
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4. The new logger group will be added to the Logger Group List.

File  Server Logger Tools Runtime Help

‘Eall “|@33&3&@\@@@£\§§

= - Server Group Logger Name Output
‘ Server1(192.168.127.200:53192)

(=83 E Logger Group List
[ <) oggerGroupl

Editing a Logger Group

Right click the logger group and then click Properties in the popup menu, or click the logger group to
select it and then click the Properties icon on the Quick Launch toolbar.

i1 MX-AOPC UA Log

Eile Server Logger Tools Runtime Help

|”-”m33ﬁﬂﬁﬁ@®££@§

=28 - Server Group Logger Name Output
- [ Server1(192.168.127.200:53152)

EH Logger Group List

New Logger
Delete

Start Recording
Stop Recording

Properties

Deleting a Logger Group

Right click the logger group and then click Delete in the popup menu, or click the logger group to select it
and then click the Delete icon on the Quick Launch toolbar.

& MX-AQPC UA Logger

Eile Server Logger Tools Runtime Help

BRI L AP EEEE

=5 - Server Group Logger Mame Type Output
------- B Serveri(192.168.127.200:53192)

= ‘:_f Logger Group List

Mew Logger
Delete

Start Recording
Stop Recording

Properties
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Loggers

In this section we explain how to use the configuration console to add, edit, and delete loggers.

Adding a Logger to a Tag Group

1. Ensure the runtime service is stopped.

2. Right click on the logger group that the logger will be added to and then click New Logger in the popup
menu, or click the logger group to select it and then click the New Logger icon on the Quick Launch
toolbar.

[CEIPS s e ey

File Server Logger Tocols Runtime Help B
DR BEROEHK 008888

B ‘ Server Group Logger Name Tige Output
5 Server1{192, 168,127, 200:53192)

E|§;f Logger Group List

New Logger
Delete

Start Recording
Stop Recording

Properties
Date Time Event
1 m i
Service Status : Stopped Time: 18:00:27 Data Supplement Queue: 0000
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3. Type in the name of the logger, configure the data file type, database or Azure IoT, and then click Next.

Logger Settings Iﬁ

Logger Mame LOga e

(max. length = 30; only 20 if using Crade Database)

(@) Excel File:
Root Path: C:\UsersPublic\Documents Moxa \MXACQPCLogger \Logger [I]
File separated every min. (default; 60)

i) Access File:
Root Path: C:\UsersPublic\Documents Moxa \MXACQPCLogger \Logger

i7) Database:

LN
m

Source Mame:

]

i) Azure IoT:

Connection String:

« Back Mext = ] [ Cancel I

> Logger Name: The naming rules of the logger name depend on the specifications of Microsoft Excel,
Access, SQL Server, Oracle Database, or Azure IoT. The naming rules can be summarized as follows:
. Microsoft Excel (max. length = 30; the first four characters: a-z, A-z; the following characters:
0-9, a-z, A-Z, _)
. Microsoft Access (max. length = 30; the following characters are NOT allowed: . ! " [1',)
] Database Source Name (DSN) and Azure IoT (max. length = 30 (only 20 if using Oracle
Database); the following characters are NOT allowed: . [ ]1',”)
» Excel File: Select this option if you would like to record data into Excel files. Configure the root path
for saving those files. Configure the time if you would like to separate the files by interval.
> Access File: Select this option if you would like to record data into Access files. Configure the root
path for saving those files.
> Database: Select this option if you would like to record data into a Microsoft SQL Server or Oracle
database. Refer to Appendix B for details on how to configure the database connection settings.

» Azure IoT: Select this option if you would like to record data in a Microsoft Azure IoT Cloud. Copy
the Connection String you got from Microsoft Azure and paste it into this field.
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Logger Management

4. Select the Data Field items, change the default names in the Table Field, change the order of the items,

and if necessary change the time format for the timestamp. Click Finish to save the settings.

Logger Settings Iﬁ
Data Field *Table Field Data Type F
<TAG_ID> <TAG_ID> String E
<WALUE= <VALUE= Siring
<UNIT > <UNIT=> String
<SOURCE_UTC_TIMESTA... <S50URCE_UTC_TIMESTA... *DateTime
<SOURCE_TIMEZOME = <SOURCE_TIMEZOME = Float

] <DATA_TYPE:
[[] <«SERVER_UTC_TIMESTA...
[] <SERVER_TIMEZOME:=
[C] <qQuALTTY=>
*max. length =30; " #£[]{}"'?., ""are not allowed
** pption: DateTime or String
[] Automatically start recording when service starts running.
< Back ][ Finish ] [ Cancel I

> Data Field: By default, data of <TAG_ID>, <VALUE>, <UNIT>, <SOURCE_UTC_TIMESTAMP>,
<SOURCE_TIMEZONE> will be recorded into the database. Data of <DATA_TYPE>,
<SERVER_UTC_TIMESTAMP>, <SERVER_TIMEZONE>, and <QUALITY> are optional. The time data
of <SOURCE_UTC_TIMESTAMP> and <SOURCE_TIMEZONE> in an OPC tag is added by Moxa’s I/O
device when the event occurs. The time data of <SERVER_UTC_TIMESTAMP> and
<SERVER_TIMEZONE> in an OPC tag is added by the MX-AOPC UA Server when the tag is received.

» Table Field: The name of each data field, which can be defined by the user, will be the column name

of the table in the database. The max. length is 30 characters.
The following characters are not allowed: ' #$[1{}"'?.,°

» Data Type: The data type of the timestamp can be either DateTime or String type. If the second

value of the timestamp has decimal points, select String type to record the decimal point value into

the database. The DateTime format only supports integer values.

> E: Move the selected item up.

> E: Move the selected item down.

> Automatically start recording when service starts running: Enable this function if you want the

logger to start recording automatically whenever the runtime service starts running.
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Editing a Logger

Take the following steps to edit a logger’s properties:

1. Ensure the runtime service is stopped.

2. Right click the logger and then click Properties in the popup menu, or click the logger to select it and

then click the Properties icon on the Quick Launch toolbar.

& MX-AOPC UA Logger

File Server Logger Tools Runtime Help

SBEENTT LT

&7 008§ |58

(=5 ‘ Server Group

----- ‘ Server1{192. 168. 127.200:53192)

Recording
[ set |[ swp |

[ Automatically start recording when service starts running

Tag Selection
E|H Logger Group List [Serverl V] [AH Device V] @ =
E‘@ LoggerGrcupl Available Tags Selected Tags
<
Delete Tag Name D » Tag Mame
i 2542-01.A1-00 E]
Start Recording 5 2542-01.A101 E
Stop Recording W 2542-0L.A1-02 E] L
T 2542-01.A1-03 -
Properties 4 ] 3
Server Name  Tag Name Description
-
Date Time Event
< [ m r
Service Status : Stopped Tirne: 19:08:49 Data Supplement Queue: 0000
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Deleting a Logger

Take the following steps to delete a logger:

1. Ensure the runtime service is stopped.
2. Right click the logger and click Delete in the popup menu, or click the logger to select it and then click
the Delete icon on the quick launch toolbar.

(T )

Eile Server Logger Tools Runtime Help

ICEHBERNSKEHO00SE 8

=5 , Server Group Recording s
s Server1(192. 168.127.200:531592) e ——
[ st | [ stp |
Automatically start recording when service starts running
Tag Selection
= Ej Logger Group List [Seruerl V] I.&H Device VI @
Eﬂ Lo?gerGrcupl Available Tags Selected Tags
-
Delete Tag Mame D » Tag Mame
& 2542-01.A1-00 E
Start Recording W 2542-01.A101 E
Stop Recording i‘g 2542-01.A1-02 E
W 2542-01.A1-03 -
Properties < ([} r
Server Mame  Tag MName Description
Date Time Event
4 I
Service Status : Stopped Time: 19:14:26 Data Supplement Queue: 0000

3. Click OK to confirm that you would like to delete this logger.

0P U toggr T
|
|

Do you really want to delete this logger?

ok || concel |
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Logger Recording

In this section we explain how to use the configuration console to select tags for recording, to start or stop

recording, and to check the status of a logger.

Select Tags for Recording

1. Ensure the runtime service is stopped.

2. Ensure that the server is connected.

3. Click the refresh button to get the updated tags from the server.

File Server Logger Tools Runtime Help

ITEE BERNEKG 00888 S

= B Server Group

LE Serverl(lgz.168.12?.200:53192}1

Recording
| start

|| Automatically start recording when service starts running

Stop

Tag Selection
=} E:f Logger Group List [Serverl '] [AJI Device ']E@ I g
&- a ‘LaggerGroupl Available Tags Selected Tags
G Logger1
Tag Mame » Tag Name
" 2542-01.A1-00 E]
W 25492-0LAI-01 E
"y 2542-01.A1-02 L4
Ty 2542-01.AL-03 E
] 1
Server Name  Tag MName Description
Date Time Event
I i r
Service Status : Stopped Time: 19:15:59 Data Supplement Queue: 0000
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4. Select the tag in the Available Tags list and click the arrow button to add it into the Selected Tags list.

Tag Selection

[Seruerl v] [All Device v]

Available Tags Selected Tags

Tag Mame

L i DAC-D1.AT-00 L4

W DAC-01.AI-01
% DAC-01.AI-02
% DAC-01.AI03 =
i 1 P i Il b

Tag Mame

33

Server Mame  Tag Mame Description

> E]: add all tags into the Selected Tags list.
> E: add a selected tag into the Selected Tags list.
> E: remove a selected tag from the Selected Tags list.

> E: removed all tags from the Selected Tags list.

5. The data from the tags in the list shown below will be recorded after the logger is in recording mode.

Tag Selection
Serverl v] [All Device v]
Available Tags Selected Tags

Tag Mame E > ; Tag Mame 4
E] ¥ DAC-0L.AI-00 L4

E] % DAC-01.AI-01

% DAC-01.AI-02
E] W DAC-01.AI-03 -

4| 1 | + [l m | [td

Server Mame  Tag Mame Description

Serverl %y DAC-01.AI-00

Serverl %y DAC-O1.AI-01
Serverl %y DAC-D1.AI-02
Serverl T DAC-01.AI-03
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Start or Stop Recording

1
2
3.
4

5.

Ensure the runtime service is running.

Ensure the server is connected.

Ensure the logger is in ready mode (indicated by green lights).

To start recording all loggers in one logger group, right click on the logger group and then click Start
Recording in the popup menu, or click the logger group to select it and then click the Start Recording
icon on the Quick Launch toolbar.

Eile Server Logger Tools Runtime Help

| @ ﬂ\ﬁﬁﬂﬂﬁﬁ@\@ﬂ\fﬁﬁ

=8 , Server Group Logger Name Output
Server1(192.168,127.200: 53:‘32}—' Logger 1 Excel C:\Users\Public\DocumentsMoxa MXAOPCLogger Y oggerLogger 1_20180125_110...

= Q Logger Group List
[=F

Mew Logger
Delete

Start Recording
Stop Recording

Properties
Date Time Event
2018/01/28 19:17:58 LoggerGroup 1.Logger 1 sucessfully connected to database!
2018/01/28 19:17:58 Initislizing database. ..
2018/01/28 1%:17:54 MX-AQPC UA Logger runtime service is running.
< ] 3
Service Status : Running Time: 19:18:06 Data Supplement Queue: 0000

All of the loggers in the logger group will be in recording mode (indicated by red lights).

Eile Server Logger Tocols PRuntime Help

= ' Server Group Logger Name Type Output
------- B Server1(192. 168,127, 200:53192) Loggerl Excel C:\Wsers\Public\DocumentsMoxa M

=~ & Logger Group List
=5 LoggerGroup1
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6. To start recording a specific logger, right click on the logger and then click Start Recording in the
popup menu, or click the logger to select it and then click the Start Recording icon on the Quick
Launch toolbar.

s
PEZCETr R .

File  Server Logger Tools Runtime Help

BRI LR T IR

=R ' Server Group

. Recording
‘ Server1{192, 168, 127.200:531932) [

sart. | | Stp |

[] Automatically start recording when service starts running
Tag Selection

EH Logger Group List | v| |
EE} LoggerGroupl Available Tags

o |8 Al

Delete Tag Mame

0
[l .

Start Recording

F Y

Stop Recording

-

Properties

7. To stop recording, right click on the logger group or the logger and then click Stop Recording in the
popup menu, or click the logger group or the logger to select it and then click the Stop Recording icon
on the Quick Launch toolbar.

'

Eile Server Logger Tools Runtime Help

| -

=5 - Server Group Logger MName Qutput
' Server1(192.165.127.200:53192) Loggerl Excel C:\WsersiPublic\Documents Mo

=38 i:j Logger Group List

- ij LoggerGroup.1

----- 4@ Loggeri MNew Logger
Delete

Start Recording
Stop Recording

Properties
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8. To check the recorded data, stop the runtime service and click the data folder of the logger. Open the
data file in the folder to check the recorded data.
File Server Logger Tools Runtime Help
ITERBERNSKRGO00SESS

(=1 ﬁ Server Group
oo [ Server1(192.168.127.200:53192)

3

Recording —,
Start Stop

[ Automatically start recording when service starts running

Tag Selection
=& Logger Group List [Sewerl - I [NI Device - ]
- i] LoggerGroupl Available Tags Selected Tags
.4 Logger1

Tag MName = » Tag Name = L
& DeviceGroup L. Device 1. TagGroup 17al E] W 2542-01.A1-00 E 1
i E2242-01.AL-00 E W 2542-01.A101
W E2242-01.A1-01 W 2542-01.A1-02
i E2242-01.A1-02 - E W 2542-0L.A1-03
] L 3 W 2542-01.010-00 -
Server Mame  Tag Mame Description =
Serverl W 2542-0LAI-00 Desc (o
Serverl S 2542-01.A1-01 Desc -
Serverl W 2542-01.A1-02 Desc
Serverl W 2542-01.A1-03 Desc =

Property

Type: Excel

Output: c: Wsers\Public\Documents \Moxa \MXACPCLogger\Logger\Logger1_20 180128_1].084(2-

Table: Loggeri

Date Time Event

2018/01/28 19:25:20 MX-A0PC UA Logger runtime service is stop.

2018/01/28 19:23:38 Start recording logger group 'LoggerGroup'

4 | i r
Service Status : Stopped Time: 19:25:49 Data Supplement Queue: 0000

¢+ Computer » Windows?_05(C:) » Users » Public » Documents

Organize = Include in library = Share with = Mew folder
W Favorites R
"= Recent Places @ Loggerl_20180128_110000.xs

4. Downloads

NOTE Be sure to close the Excel or Access file at the target root path before starting to record. Otherwise, the MX-
AOPC UA Logger will not be able to record data to the target file.

NOTE DO NOT open the spreadsheet when recording. Doing so will cause the file to be corrupted because it is
already opened by the MX-AOPC UA Logger service. To open the spreadsheet, stop the runtime service of
the MX-AOPC UA Logger, and then click the folder icon to access the file.
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Logger Status

The following table gives the meanings of the logger status indicator lights.

Light

Color

Status

Note

Solid Gray

Configurable Mode

The logger can be configured only when
runtime service stops.

Any configuration change will be updated to
the Logger’s runtime service after starting the
runtime service. Without starting the runtime
service, any change will be discarded after the
configuration console is closed. Be sure to
save your project file when you close the
configuration console.

Solid Green

Ready Mode

The logger is ready for recording.

Solid Red

Recording Mode

The logger is recording.

Solid Yellow

Error Mode - Configuration

The logger is not configured correctly, and
data is not being saved to the database.
Check the tag selection or database
connection of the logger.

Flashing Red
and Yellow

Error Mode - Server

A server related to some selected tags is
disconnected.

Check the server connection or server'’s
Endpoint settings.

Flashing Pink
and Gray

Data Supplement Mode

The logger is retrieving supplementary data
from device’s buffer storage or supplementing
data into the database.
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License Registration and Activation

Two versions of the MX-AOPC UA Logger are available. The trial version, which supports up to 1 MX-AOPC
UA Server connection and up to 1 data logger, can be installed and used for 30 days without registration. To

use the free version, you must submit a license registration. The free version only supports up to 1 MX-

AOPC UA Server connection and up to 1 data logger indefinitely. The two versions are summarized in the

following table:

Version MX-AOPC UA Server connection Data Logger Run Time License File
Trial Upto1l Upto1l 30 days Not Required
Free Upto1 Upto1l Unlimited Required

Take the following steps to register a license.

Step 1:

Get the PC User Code from the MX-AOPC UA Logger’s configuration console by clicking Help - License.

License Info

L X

—

User Code: 464EB14358CD
License Status: Free Version
The max., number of Server: 1

The max. number of Logger: 1

Step 2:

Go to Moxa's website (https://www.moxa.com) and log in with your Moxa account and password, or apply

for an account if this is your first visit to the site. Navigate to Support > Software License Management

to access the license portal.

MOXA

Defend Yo
Networks

Products Solutions

Product Support Repair & Warranty

Software & Documentatio Product Repair Service/RMA

Product FAQs Warranty Policy

Security Advisorigg

[ Software License Management

Software Life-cycle Policy

Still need assistance with your Moxa product? CONTACTUS >

How to Buy

ContactUs | Partner Zone | My Moxa SignIn

About Us Q

Resources

Literature Library
Case Studies

Article Library



https://www.moxa.com/
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Step 3:
On the Software Licensing website, navigate to Products and Licenses - Activate a Product License.
Select MX-AOPC UA Logger from Product Type, select Free Version from Sub Product Type, and enter

the User Code.

Product Type MX-AOPC UA Logger v
Sub Product Type Free License v
User code Enter your user code

[ Products and LICEHSES v l Download ¥ So

View Activated Products I

[ Activate a Product License ]

Request an add-on or renewal License
Activate an add-on or renewal License

Transfer a Product License

Step 4:
Download the license file to a folder on your PC.

Message notification

Your license has been activated, please download the license file from
below.

oo
Step 5:

From the MX-AOPC UA Logger’s configuration console, click Help > Licensing > Add License File to add
the license file (.lic) to the MX-AOPC UA Logger.

&4 MX-AOPC UA Logger - Di\charleszk c
File Server Logger Tools Runtlmel

— Logger Help
il Licensing k License Info
= ﬁ Server Group About..., Add License File

------- m Server1(192,168.12.112:5319 ‘ | Deactivate License
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Step 6:
After license activation is complete, go to Help > License Info to check the current license status.

wsore s N ==

Your license has been activated. The new license will take effect after
runtime service restarts,

e -

User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1




A

System Performance Reference

These performance results provide a reference for evaluating MX-AOPC UA Logger’s capability when
designing a system architecture. The results show the maximum number of tags of data that can be

recorded into the database without resulting in a data queue.

CPU: i7-4790, 3.60 GHz

RAM: 8 GB

Operating System: Microsoft Windows 7

Editor: Microsoft Office 2010 Access and Excel

Database: Oracle database, Microsoft SQL Server, MySQL
OPC UA Software: MX-AOPC UA Server & MX-AOPC UA Logger
Cloud: Azure IoT

Test Case:

» One database at a time

» Disabled data supplement function

> Only running real-time data recording function

Max. No. of Tags Max. No. of Tags
Database Type Database
(per 1 second) (per 5 seconds)
File Excel 2000 10000
File Access 3000 15000
DSN Excel 2000 10000
DSN Access 3000 15000
DSN Microsoft SQL 1300 6500
DSN Oracle 2000 10000
DSN MySQL 800 4000
Cloud Azure IoT 30 150




Database Connection Settings

In this chapter, we explain how to connect a Logger to a Microsoft SQL Server or Oracle database.

1. Open ODBC Data Source Administrator by typing “odbcad32.exe” in the Windows Start search field,
and then click it.

Programs (1)

, 5 ocdbcad32. exe

|f-\.
=~ 5ee more results

| odbcad32.exd ® | | Hibernate |_b|

B Documents
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2. Click the System DNS tab and then click Add.

I =

- ODBC Data Source Administrator @

| User DSN | System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame Driver Add...

An ODBC System data source stores information about how to connect to
D; the indicated data provider. A System data source is visible to all users
= an this machine, including NT services.

0K || Cancl Aoply Help

=]

3. Select ODBC driver for Oracle if you are using an Oracle database, and select ODBC Driver xx for
SQL Server if you are using a Microsoft SQL Server. In the example shown below, "ODBC Driver 11 for
SQL Server” is selected. Click Finish to go to the next step.

- 1

Create Mew Data Source @

Select a driver for which you want to set up a data source.

; MName L &
|
| Microsoft Tesd Driver (“bd; *.csv) 6
a1t | Microsoft Tesd-Treiber (“bd; *.csv) 6
Microsoft YVisual FoxPro Driver 1
Microsoft Visual FoxPro-Treiber 1
QDBC Driver 11 for SAL Server 2=
SQL Server 6[E|
S0QL Server MNative Client 11.0 2
1 | 1] [ 3
< Back Finish ] [ Cancel

NOTE MX-AOPC UA Logger supports Oracle database (x86) and Microsoft SQL Server (x86) connections.
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4. Type a name for the data source in the Name field. Click the Server field down arrow to search for

instances of SQL Server. Select your target SQL Server, and then click Finish.

e

Create a Mew Data Source to S50L Server

o SQL Server.

-

SOL Server

This wizard will help you create an ODBC data source that you can use to connect to
What name do you want to use to refer to the data source?
MName:

How do you wart to describe the data source?

Description:

Which SQL Server do you want to connect to?

Server:

-

=)

MS5GL

IETTWINTSOLEXPRESS

Finish

|

Net> | | Cancel | [ Heb

Click Test Data Source to test the connection, or click OK to proceed.

e

ODBC Microsoft SOL Server Setup

Data Source Name: MS5GL

Data Source Description:

Server: IETTWINTWSQLEXPRESS

lUse Integrated Securty: Yes

Database: (Default)

Language: (Default)

Data Encryption: Mo

Trust Server Cerificate: Mo

Multiple Active Result Sets{(MARS): No
Translate Character Data: Yes

Log Long Running Gueries: No

Log Driver Statistics: Mo

Ilse Regional Settings: Mo

Ize AMSI Quoted |dentifiers: Yes

IUse AMSI Mull, Paddings and Wamings: Yes
Server Service Principle Mame(SPN):
Mimor Server Service Principle Name({SPM):

Anew ODBC data source will be created with the following configuration:

Microgsoft ODBC Driver for SQL Server Version 12.00.2000 »

-

[l

Test Data Source...

| [ ox

Cancel

J |
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6. Click OK to complete ODBC Data Source settings.

I =

;_! QDBC Data Source Administrator

| User DSN | System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Mame  Driver Ad

| xEls ODBC Driver 11 for SQL Server T —

Corfigure. ..

11

An ODBC System data source stores information about how to connect to
m; the indicated data provider. A System data source is visible to all users
= an this machine, including NT services.

| ok || cancel Apply Help
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7. Open Microsoft SQL Server Manage Studio. Right click on Security > Logins > NT

AUTHORITY\SYSTEM, and then click Properties.

File

Edit

Object Explorer
Connect = * x*

View Debug Tools

- -2

¢

L"x: Microsoft SQL Server Management Studic (Administrator)
Window

#|J%NEWQ'-JE’}' J% hlu‘-ﬁ::' eI 3

Help

» 0 X

=
=

= @ CHARLESCHEN-ME (SQL Server 12.0.5000.0 - HQIDC

Databases
Security
Lagins

ae ZEMS_PolicyEventProcessingloging?
me 22MS_PolicyTsqlExecutionLogind®

L NT AUTHORITY\SYSTEM

aa NT Service\MSSQL!
pa NT SERVICE\SQLSE
aa NT SERVICE\SQLWI
aa NT SERVICE\Winm
e 53
Server Roles
Credentials
Cryptographic Provide
Audits
Server Audit Specificati
Server Objects
Replication
Always On High Availabilit
Management

Mew Login...

Script Login as 3

Policies 3

Facets

Start PowerShell

Reports 3

Rename

Delete

Refrezh
Properties

Integration Services Catalogs
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8. Ensure the default database is master.

[ss IT Scipt ~ @) Help

Login name: NT AUTHORITY\SYSTEM Search... i

& Server Rdles
@ Windows authentication

& User Mapping
# Securables
F Status

SQL Server authentication

Password: | |

Corfirm password: | |
Specify old password

Old password: | |

[] Erforce password palicy
[] Enforce password expiration

[] User must change password at nest login

Mapped to cedificate | - |
Connection Mapped to asymmetric key | . |
Map to Credential | [ Add
Mapped Credentials Credential Provider
¥ Migw connection properties
Progress | Remave
Ready Default database: lmaster 'n
Default language: [E@Sh 'T

[ ok || Ccancel
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9. Ensure that Public for Server Roles is enabled.

IT Scipt ~ @ Help

ser Mapping Server role is used to grant server-wide securty privileges to a user.

# Securables
F Status

Server roles:
bulkadmin
dbcreator
dishiadmin
pegadmin

fadmin
serveradmin
setupadmin

sysadmin

¢¥ VMiew connection properties

Ready

[ ok ]| Ccancel
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10. Enable the Master Database of the User Mapping, and enable the db_owner and public roles of the
master.

ra = n ™y
8 oo e oo I ok

IT Scipt ~ @ Help

Users mapped to this login:
Map Database User Default Schema

i master NT AUTHORITY\SYS..  dbo i
[ model
msdb
tempdb

[¥/] Guest account enabled for: master

Database role membership for: master

db_accessadmin

| db_backupoperator
\ |[] db_datareader

\[[] db_datawriter
db_ddladmin

\ W | db_denydatareader
t |¥] db_denydatawriter

¢¥ View connection properties

Progress | |[¥] db_owner
sl || db_securityadmin

V] public
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11. Select the Database option when setting the Logger’s data destination, and then click Setting.

Logger Mame Loggerl

(max. length = 30; anly 20 if using Orade Database)

() Excel File:
Root Path: C:\Users'Public\DocumentsMoxa \MXAQPCLogger \Logger
Output Folder:  Loggerl 20180128 _110840
File separated every | &0 min. (default; 60)
i) Access File:
Root Path: C:\UsersPublic\Documents Moxa \MXACQPCLogger \Logger
Output Folder:
@ Database:
Source Mame:
i) Azure IoT:

Connection String:

« Back Mext = ] [ Cancel

12. Click the Machine Data Source tab, select the SQL Server data source, and then click OK.
Select Data Source
File Data Source | Machine Data Source

Data Source Name Type Description
dBASE Files |zer
Bxcel Files |zer
M5 Access Database |zer

Sysen

A Machine Data Source is specific to this machine, and cannat be shared.
"User" data sources are specific to a user on this machine. "System” data
sources can be used by all users on this machine, or by a system-wide service.

| oK || Cancel || Hep

NOTE DO NOT click NEW from this window to configure ODBC Data Source settings. You will not be able to
successfully connect the logger with the database.
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13. The data source name is displayed in the Source Name field. Click NEXT to continue the Logger
Settings. Refer to Chapter 5 for information about the following settings.

corsenrs: . ==

Logger Mame Loggerl

(max. length = 30; anly 20 if using Orade Database)

() Excel File:
Root Path: C:\Users‘Public\DocumentsMoxa \MXAQPCLogger \Logger | _|
Output Folder:  Loggerl 20180123 _110840
File separated every iﬁlj vi min. (default; 60)

i) Access File:
Root Path: |C: WWsers\Public\DocumentsMoxa MXADPCLogger \Logger i | |
Output Folder:

i@ Database:
Source Mame: FSSEIL Setting

i) Azure IoT:

Connection Sh'ing.'i |
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